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IMPORTANT! Before using this product, read and understand the information in the “Safety” appendix
in this document.

Product description

The Yfiler™ Plus PCR Amplification Kit is a 6-dye, short tandem repeat (STR) multiplex assay for the
amplification of human genomic DNA. The kit is optimized for multiple male-specific sample types such
as male-male, male-female mixtures.

The kit amplifies 27 Y-STR loci: DYS576, DYS389I1, DYS635, DYS389Il, DYS627, DYS460, DYS458,
DYS19, YGATAH4, DYS448, DYS391, DYS456, DYS390, DYS438, DYS392, DYS518, DYS570, DYS437,
DYS385 a/b, DYS449, DYS393, DYS439, DYS481, DYF387S1 a/b, DYS533

The Yfiler™ Plus kit uses the same improved process for synthesis and purification of the amplification
primers that were previously developed for other next-generation Thermo Fisher Scientific STR
chemistries. The improved amplification primers deliver clean electrophoretic backgrounds that help
interpretation.

Single-source sample types supported

The Yfiler™ Plus kit is optimized to allow direct amplification from the following types of single-source
samples without the need for sample purification:

* Blood and buccal samples on treated paper substrates.
* Blood samples collected on untreated paper substrates and treated with Prep-n-Go™ Buffer.
* Buccal samples collected on swab substrates and treated with Prep-n-Go™ Buffer.
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Chapter 1 Product information &8
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Product description

Non-nucleotide linkers are used in primer synthesis for the following loci: DYS389l/1l, DYS635, DYS627,
DYS19, YGATAH4, DYS448, DYS391, DYS390, DYS438, DYS392, DYS518, DYS437, and DYS449.

For these primers, non-nucleotide linkers are placed between the primers and the fluorescent dye
during oligonucleotide synthesis (Butler 2005, Grossman et al., 1994). Non-nucleotide linkers enable
reproducible positioning of the alleles to facilitate interlocus spacing. The combination of a 6-dye
fluorescent system and the use of non-nucleotide linkers allows simultaneous amplification and efficient

separation of the 27 Y-STR loci during automated DNA fragment analysis.

Dyes used in the kit

Dye Color Label
6-FAM™ Blue Samples, allelic ladders, and controls
vic™ Green
NED™ Yellow
TAZ™ Red
SID™ Purple
Liz™ Orange GeneScan™ 600 LIZ™ Size Standard v2.0

Yfiler™ Plus PCR Amplification Kit User Guide



E# Chapter 1 Product information
Product description

Loci amplified by the kit

Locus designation Alleles in the allelic ladder Dye label| Alocs It BUA
DYS576 10,11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25 6-FAM™ |19
DYS389l 9,10, 11,12, 13, 14, 15, 16, 17 13
DYS635 15,16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27, 28, 29, 30 24
DYS389 24,25, 26, 27, 28, 29, 30, 31, 32, 33, 34, 35 29
DYS627 11,12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27 21
DYS460 7,8,9,10, 11,12, 13, 14 vicr |11
DYS458 11,12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24 17
DYS19 9,10, 11, 12, 13, 14, 15, 16, 17, 18, 19 15
YGATAH4 8,9,10, 11, 12, 13,14, 15 13
DYS448 14,15, 16, 17, 18, 19, 20, 21, 22, 23, 24 19
DYS391 5,6,7,8,9,10, 11,12, 13, 14, 15, 16 11
DYS456 10,11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24 NED™ |15
DYS390 17,18, 19, 20, 21, 22, 23, 24, 25, 26, 27, 28, 29 24
DYS438 6,7,8,9,10, 11,12, 13, 14, 15, 16 12
DYS392 4,5,6,7,8,9,10, 11,12, 13, 14, 15, 16, 17, 18, 19, 20 13
DYS518 32,33, 34, 35, 36, 37, 38, 39, 40, 41, 42, 43, 44, 45, 46, 47, 48, 49 37
DYS570 10,11, 12, 13, 14, 15, 16,17, 18, 19, 20, 21, 22, 23, 24,25,26 | TAZ™ |17
DYS437 10, 11,12, 13, 14, 15, 16, 17, 18 15
DYS385 a/b 6,7,8,9,10, 11,12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 11,14
25,26, 27, 28
DYS449 22,23, 24, 25, 26, 27, 28, 29, 30, 31, 32, 33, 34, 35, 36, 37, 38, 39, 30
40

DYS393 7,8,9,10, 11,12, 13, 14, 15, 16, 17, 18 sib» |13
DYS439 6,7,8,9,10, 11, 12, 13, 14, 15, 16, 17 12
DYS481 17,18, 19, 20, 21, 22, 23, 24, 25, 26, 27, 28, 29, 30, 31, 32 22
DYF387S1a/b 30,31, 32, 33, 34, 35, 36, 37, 38, 39, 40, 41, 42, 43, 44 35,37
DYS533 7,8,9,10, 11,12, 13, 14, 15, 16, 17 13
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Product description

Standards and controls that are required

The Yfiler™ Plus kit requires the following standards and controls for PCR amplification, PCR product

sizing, and genotyping:

o

Item Description Include_d in the
kit
DNA Control 007 Positive control. Used to evaluate amplification efficiency
and to evaluate STR genotyping using the kit allelic ladder. Yes
See “DNA Control 007 profile” on page 12.
Yfiler™ Plus Allelic Ladder Developed for accurate characterization of the alleles
amplified in the kit. The allelic ladder allows automatic
genotyping of most of the reported alleles for the loci in the Yes
kit. See “Loci amplified by the kit” on page 10 and “Allelic
ladder profile” on page 13.
GeneScan™ 600 LIZ™ Used for obtaining sizing results. This standard, which has
. . ; ) . No (order
Size Standard v2.0 been evaluated as an internal size standard, yields precise separately)
(Cat. No. 4408399) sizing results for PCR products. P Y
Yfiler™ Plus PCR Ampilification Kit User Guide 11
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Chapter 1 Product information
Contents and storage

Contents and storage

The Yfiler™ Plus kit contains sufficient quantities of the reagents for 100 (Cat. No. 4484678) or 500
(Cat. No. 4482730) amplification reactions at 25 plL/reaction.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer set
and allelic ladder from light when not in use.

IMPORTANT! The allelic ladder contains PCR products that should not be amplified. To avoid
contamination, store the allelic ladder separately from the other kit components and unamplified DNA.

Note: If there is more than one tube or bottle for a single reagent, thaw only the number of tubes or
bottles required for the current number of reactions.

IMPORTANT! Do not refreeze kit components after thawing.

Note: For recommendations on kit handling, go to thermofisher.com, then search for Technical
Note: Handling STR Kits and Ladder Decontamination, or contact your local Human Identification
representative.

Amount
. 1
Item Description 100 reactions 500 reactions Storagel'l
(Cat. No. 4484678) (Cat. No. 4482730)
Yfiler™ Plus | Contains enzyme, salts, 2x0.5mL 4 x1.25mL —25°C to —15°C on receipt.

Master Mix | dNTPs, bovine serum

2-8°C after first use, up to
the expiration date stated on
the kit.

albumin, and 0.05%
sodium azide in buffer
and salt.

DNA
Control 007 | male genomic DNA in

Contains 2 ng/pL human 1 x0.05 mL 2 x 0.05mL
0.05% sodium azide and
buffer. [

See “DNA Control 007
profile” on page 12.

14
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(continued)
Amount
— 1
ltem Description 100 reactions 500 reactions Storagel'!
(Cat. No. 4484678) (Cat. No. 4482730)
Yfiler™ Plus | Contains forward and 2 x0.25mL 2x1.25mL —-25°C to —15°C on receipt.
Primer Set ;emve:;e ESE:;SSE A 2-8°C after first use, up to
; P ty the expiration date stated on
argets. the kit.
Allelic alleles.
Ladder

See “Allelic ladder
profile” on page 13.

' See packaging for expiration date. Do not use expired product.

1 DNA Control 007 is included at a concentration that is appropriate for use as an amplification control (that is, to provide confirmation that the
kit reagents can generate a profile of expected genotype). It is not designed for use as a DNA quantification control. If you quantify aliquots of

DNA Control 007, the concentration may differ from the labeled concentration.

Required materials not supplied

See Appendix C, “Materials required but not supplied”.

Yfiler™ Plus PCR Amplification Kit User Guide
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Instruments and software compatibility

Note: Compatible instruments and software that have been discontinued are not listed in this user
guide.

Thermal cyclers
¢ HID VeritiPro™ Thermal Cycler, 96-well
* ProFlex™ 96-well PCR System
* ProFlex™ 2 x 96-well PCR System
* ProFlex™ 3 x 32-Well PCR System

Genetic analyzers and data collection software

Genetic analyzer Data collection software

SeqStudio™ Flex Series Genetic Analyzer for SeqStudio™ Flex Series Instrument Software v1.1.1
Human Identification

SegStudio™ Genetic Analyzer for HID SeqgStudio™ Data Collection Software v1.2.5

SeqgStudio™ Data Collection Software v1.2.4

SeqgStudio™ Data Collection Software v1.2.1

3500 Series Genetic Analyzer for Human 3500 Series HID Data Collection Software v4.0.1
Identification

3500 Series Data Collection Software 4 (Windows™ 10
operating system)

Analysis software

Genetic analyzer Analysis software
SeqStudio™ Flex Series Genetic Analyzer for Human GeneMapper™ ID-X Software v1.7.2 or later
Identification
SeqgStudio™ Genetic Analyzer for HID GeneMapper™ ID-X Software v1.6 or later
3500 Series Genetic Analyzer for Human Identification GeneMapper™ ID-X Software v1.5 or later

For more information
* For the instruments and software used during the kit validation, see Chapter 6, “Experiments and
results”.

* For testing information on specific platforms, see the instrument or software user documentation.
* For ordering information, see Appendix C, “Materials required but not supplied”.
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Workflows

Workflows

Process casework (extracted DNA) samples with the Yfiler™ Plus PCR

Amplification Kit

Extract and quantify DNA

1. Extract DNA—Go to: www.thermofisher.com/hid-sampleprep
2. Quantify DNA—See “DNA quantification” on page 19

Perform PCR

1. “Prepare the amplification kit reactions” on page 21
2. “Extracted DNA: Perform PCR” on page 22

Perform capillary electrophoresis

1. “(Before first use of the kit) Set up the capillary electrophoresis instrument” on page 34
2. “Prepare samples for electrophoresis and start the run” on page 37)

Analyze data

“Set up the GeneMapper™ ID-X Software for analysis (before first use of the kit)” on page 41
“Create an analysis method” on page 47

“(If needed) Create a size standard definition file” on page 55

“Analyze and edit sample files with GeneMapper™ ID-X Software” on page 58

“Examine or edit a project” on page 58

oM 0Dnp
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Workflows

Process database (direct amplification) samples with the Yfiler™ Plus

PCR Amplification Kit

Perform PCR

1. “Direct amplification: Treated and untreated paper substrates” on page 26, or
“Direct amplification: Swab substrates” on page 29
2. “Direct amplification: Perform PCR” on page 32

Perform capillary electrophoresis

1. “(Before first use of the kit) Set up the capillary electrophoresis instrument” on page 34
2. “Prepare samples for electrophoresis and start the run” on page 37)

Analyze data

“Set up the GeneMapper™ ID-X Software for analysis (before first use of the kit)” on page 41
“Create an analysis method” on page 47

“(If needed) Create a size standard definition file” on page 55

“Analyze and edit sample files with GeneMapper™ ID-X Software” on page 58

“Examine or edit a project” on page 58

oM 0Dnp
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Validated DNA amounts and PCR cycles

The kit is validated for use with <1 ng of DNA for 30 PCR cycles. The DNA input volume is 10 L, for a
total reaction volume of 25 pL.

Extracted DNA: Perform PCR

Validated DNA amounts and PCR CYCIES . ... ..ottt i i et e e 19
DNA quantification . ...... .. i e e e 19
Before yoU Degin ... ... e e 21
Prepare the amplification kitreactions ......... ... .. . i e 21
Extracted DNA: Perform PCR ... ... e e 22

DNA quantification

Importance of DNA quantification before STR analysis

DNA quantification can be used to determine the following:

If the sample contains sufficient human DNA and/or human male DNA to proceed with short
tandem repeat (STR) amplification.

(When using the Quantifiler™ Trio DNA Quantification Kit) The relative quantities of human male and
female DNA in a sample. Relative quantities can help you select the appropriate STR chemistry.

The amount of sample to use in STR analysis applications.

If PCR inhibitors are present in a sample. If inhibitors are present, the sample may require additional
purification before proceeding to STR analysis.

The DNA quality, in regards to the inhibition level and the DNA degradation level. DNA quality can
help you determine the likelihood of recovery of STR loci with larger amplicon sizes.

Note: Highly degraded samples that cannot be recovered by STR analysis with capillary
electrophoresis can be analyzed with the Precision ID NGS System and Panels. Optimized for
degraded samples, the Precision ID Identity Panel enables discrimination of individuals similar to
STR genotype match probabilities. The Precision ID Ancestry Panel infers biogeographical ancestry
for investigative leads.
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DNA quantification

Effect of DNA quantity on results

If too much DNA is added to the PCR reaction, the increased amount of PCR product that is generated
can result in the following:

* Fluorescence intensity that exceeds the linear dynamic range for detection by the capillary
electrophoresis instrument (“off-scale” data). Off-scale data are a problem because:

- Quantification (peak height and area) for off-scale peaks is not accurate. For example, an allele
peak that is off-scale can cause a corresponding stutter peak to appear higher in relative
intensity, therefore increasing the calculated percent stutter.

— Multicomponent analysis of off-scale data is not accurate. This inaccuracy results in poor
spectral separation (“pull-up”).

* |ncomplete +A nucleotide addition.
To address these problems, rerun the amplification reaction using less DNA.

If too little DNA is added to the PCR reaction, the total number of allele copies added to the
PCR reaction could be extremely low. Unbalanced amplification of the alleles can occur because of
stochastic fluctuation.

Methods of quantifying DNA

Kit Detects How it works
Quantifiler™ HP DNA * Total human DNA | ¢ Uses 5' nuclease assays with multiple-copy target loci, for
Quantification Kit (two targets—one improved detection sensitivity:!']
(Cat. No. 4482911) small amplicon - The human-specific target loci are multiple-copy, and
and one larger dispersed on various autosomal chromosomes
amplicon)

— The primary quantification targets have relatively short
* Degraded DNA amplicons (75-80 bases), to improve the detection of
degraded DNA samples

Quantifiler™ Trio DNA | ¢ Totalhuman DNA | e yses features that maximize consistency of quantification:
Quantification Kit (two targets—one

- Genomic targets have conserved primer- and probe-

(Cat. No. 4482910) small amplicon binding sites
and one larger . L .
amplicon) — Minimal copy number variation between different

individuals and population groups
* Human male DNA Pop grodp

* Contains a Large Autosomal target with a longer amplicon
* Degraded DNA

(>200 bases) to help determine if a DNA sample is degraded

' The detection sensitivity of the Quantifiler™ HP Kit and the Quantifiler™ Trio kit is improved over the Quantifiler™ Duo Kit.

Note: For information on the Quantifiler™ kits, see the Quantifiler™ HP and Quantifiler™ Trio DNA
Quantification Kits User Guide (Pub. No. 4485354).
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Chapter 2 Extracted DNA: Perform PCR 51
Before you begin

Before you begin

(Optional) Prepare low-TE buffer

For optimal results, we recommend using low-TE buffer for sample preparation. Prepare the low-TE
buffer as described in this procedure or purchase TE Buffer (Cat. No. 12090015).
1. Mix the buffer components together.
e 10 mL of 1 M Tris-HCI, pH 8.0
* 0.2mL of 0.5 M EDTA, pH 8.0
* 990 mL glass-distilled or deionized water

Note: Adjust the volumes proportionally for specific needs.

2. Aliquot, then autoclave the solutions.

3. Store the aliquots at room temperature.

(Before first use of the kit) Thaw reagents

Thaw the master mix and primer set.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer set
and allelic ladder from light when not in use.

IMPORTANT! Thawing is required only before first use of the kit. After first use, the reagents are stored
at 2-8°C and do not require subsequent thawing. Do not refreeze the reagents.

Prepare the amplification kit reactions

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer set
and allelic ladder from light when not in use.

1. Vortex the master mix and primer set for 3 seconds. Before opening the tubes or bottles, remove
droplets from the caps by briefly centrifuging the tubes or tapping the bottles on the bench.

2. Pipet the required component volumes into an appropriately sized, clear (non-colored),

polypropylene tube.

Component Amount per reaction
Master mix 10.0 yL
Primer set 5.0 uL

Note: Include volume for extra reactions to provide excess volume for the loss that occurs during
reagent transfers.
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Extracted DNA: Perform PCR

3. Vortex the reaction mix for 3 seconds, then briefly centrifuge.

4. Pipet 15 pL of the reaction mix into each well of a MicroAmp™ Optical 96-Well Reaction Plate or
each MicroAmp™ tube.

5. (If needed) Adjust the sample input amount and volume.

¢ If the total sample input amount is >1.0 ng, dilute with low-TE buffer to obtain a 10-pL input
volume.

¢ If the total sample volume is <10 yL, bring to volume with low-TE buffer to obtain a 10-pL input
volume.

6. Prepare the samples and controls as shown in the following table, then add to the appropriate
wells of a MicroAmp™ Optical 96-Well Reaction Plate or to each MicroAmp™ tube.

Amount per reaction
Component

30-cycle protocol

Negative control 10 pL of low-TE buffer

Test sample DNA to a total amount of 1.0 ng

Positive control DNA Control 007 to a total amount of 1.0 ng

Note: DNA Control 007 contains 2 ng/uL of human male genomic DNA.

The final reaction volume (sample or control plus reaction mix) is 25 pL.

7. Seal the plate with MicroAmp™ Clear Adhesive Film or MicroAmp™ Optical Adhesive Film, or cap
the tubes.

IMPORTANT! We recommend adhesive film for plate sealing to provide a consistent seal across
all wells and prevent evaporation. Do not use caps for the plate, which may not provide a
consistent seal across all wells.

8. Vortex the plate or tubes at medium speed for 3 seconds.

9. Centrifuge the tubes or plate at 3,000 x g for ~20 seconds in a tabletop centrifuge (with plate
holders, if using 96-well plates).

Proceed to “Extracted DNA: Perform PCR” on page 22.

Extracted DNA: Perform PCR

IMPORTANT! The kit is optimized for use with the thermal cyclers that are listed in “Instruments and
software compatibility” on page 16 .

1. Program the thermal cycler.
a. Set the ramping mode to 9600 Simulation.
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Extracted DNA: Perform PCR

b. Set the thermal cycling conditions as shown in the following table.

[0

Cycle (30 cycles)!!]
Initial incubation step Final extension Final hold
Denature Anneal/Extend
HOLD CYCLE HOLD HOLD
95°C 94°C 61.5°C 60°C 4°C
1 minute 4 seconds 1 minute 22 minutes <24 hoursl?

[ See “Validated DNA amounts and PCR cycles” on page 19.

' The infinity (o) setting allows an unlimited hold time.

2. Load the plate or tubes into the thermal cycler, close the heated cover, then start the run.

3. When the run is complete, store the amplified DNA.

Storage time Temperature
<2 weeks 2-8°C
>2 weeks —-25°C to -15°C

IMPORTANT! Protect the amplified DNA from light.
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(Before first use of the kit) Optimize PCR cycle number

Direct amplification: Perform PCR

(Before first use of the kit) Optimize PCRcyclenumber ............. ... ..o i, 24
(Before first use of the kit) Thaw reagents ...........cco it i i i 25
Direct amplification: Treated and untreated paper substrates ............................... 26
Direct amplification: Swab substrates .......... ... i e e 29
Direct amplification: Perform PCR .. ... ... et i e 32

Before using the Yfiler™ Plus kit for the first time, perform a single initial sensitivity experiment to
determine the appropriate cycle number to use during internal validation studies and operational use

of the kit. This experiment accounts for instrument-to-instrument and sample-to-sample variations. If
you are processing multiple sample type and substrate combinations (for example, buccal samples on
treated paper and buccal samples on swabs), perform separate sensitivity experiments for each sample
type and substrate to be used for testing.

Procedural guidelines when optimizing PCR cycle number

To minimize the impact of run-to-run variation on the results, use 26 samples so that you can
complete electrophoresis with a single 96-well plate. For examples of PCR and electrophoresis
plate layouts, see Appendix D, “Plate layouts”.

To minimize the effect of instrument-to-instrument variation, use the same thermal cycler to amplify
all 3 plates.

To maximize result quality, prepare and amplify Plate 1, then repeat for Plates 2 and 3. Do not
prepare all 3 plates simultaneously.

If the average peak heights fall outside the 5,000-12,000 RFU range, test more cycle numbers
or fewer cycle numbers to obtain optimal peak heights. For more information about peak height
range, see “Determine optimum PCR conditions” on page 25.

Select samples and prepare plates

1.

24

Select 26 of each sample+substrate type. Ensure that the selected samples represent a "typical"
range of samples analyzed in your laboratory.

Prepare the samples and the reactions as described in the appropriate protocols later in this
chapter. Prepare sufficient PCR reagents to complete amplification of 3 replicate plates.

Create the first of 3 identical PCR plates. For a suggested plate layout, see “Example PCR plate
layout” on page 121.
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(Before first use of the kit) Thaw reagents

4. Amplify each plate using a different cycle number to determine the optimum conditions for use in
your laboratory.

Suggested cycle numbers for different sample type and substrate combinations are listed in the
following table.

Substrate
Sample type
Treated or untreated paper
Blood 27, 28, 29 cycles
Buccal 27, 28, 29 cycles

Note: Our testing has not included blood samples on swab substrates. This sample type is not
often used for the collection of database or casework reference samples.

Determine optimum PCR conditions

1. Run the PCR products on the appropriate CE platform using the recommended protocol that is
described in Chapter 4, “Perform electrophoresis”.

2. Based on the results of the sensitivity study, select the appropriate PCR cycle number for future
experiments.

The optimum PCR cycle number should generate full profiles with no instances of allelic dropout and
minimal occurrences of off-scale peaks. Heterozygote peak heights should be 5,000-12,000 RFU for
the following instruments:

* SegStudio™ Flex Series Genetic Analyzer for Human Identification
* SeqgStudio™ Genetic Analyzer for HID
¢ 3500 Series Genetic Analyzer for Human Identification
When amplifying single-source, unpurified samples, you may see greater sample-to-sample variation

in peak height than you see with purified samples. Careful optimization of the cycle number helps to
minimize this variation.

(Before first use of the kit) Thaw reagents

Thaw the master mix and primer set.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer set
and allelic ladder from light when not in use.

IMPORTANT! Thawing is required only before first use of the kit. After first use, the reagents are stored
at 2-8°C and do not require subsequent thawing. Do not refreeze the reagents.
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Direct amplification: Treated and untreated paper substrates

Direct amplification: Treated and untreated paper
substrates

Sample preparation guidelines: Treated or untreated paper substrate

* Do not add water to the wells on the reaction plate before adding the punches. If you observe
static issues with the paper discs, you can prepare and dispense the 25-uL reaction mix into the
wells of the reaction plate before adding the punches.

* To facilitate optimum peak intensity, make a 1.2-mm punch as close as possible to the center of
the sample. Increasing the size of the punch may cause inhibition during PCR amplification.

* For manual punching: Place the tip of a 1.2-mm Harris Micro-Punch™ on the card, hold the barrel of
the Harris Micro-Punch™ (do not touch the plunger), gently press and twist 1/4-turn, then eject the
punch into the appropriate well on the reaction plate.

* For automated punching: For guidance, see the user guide for your automated or semi-automated
disc punch instrument.

* For blood on untreated paper samples, add 2 pL of Prep-n-Go™ Buffer (for use with untreated paper
substrates) on top of the 1.2-mm sample punch.

26 Yfiler™ Plus PCR Amplification Kit User Guide



Chapter 3 Direct amplification: Perform PCR 5%
Direct amplification: Treated and untreated paper substrates

(Optional) Prepare low-TE buffer

For optimal results, we recommend using low-TE buffer for sample preparation. Prepare the low-TE
buffer as described in this procedure or purchase TE Buffer (Cat. No. 12090015).

1. Mix the buffer components together.
e 10 mL of 1 M Tris-HCI, pH 8.0
e 0.2mL of 0.5 M EDTA, pH 8.0
* 990 mL glass-distilled or deionized water

Note: Adjust the volumes proportionally for specific needs.

2. Aliquot, then autoclave the solutions.

3. Store the aliquots at room temperature.
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Direct amplification: Treated and untreated paper substrates

Prepare the amplification kit reactions: Treated or untreated paper
substrates

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer set
and allelic ladder from light when not in use.

1. Prepare the samples and controls as shown in the following table, then add to the appropriate
wells of a MicroAmp™ Optical 96-Well Reaction Plate.

Amount per reaction

Component
26-cycle protocol 27-cycle protocol 28- and 29-cycle protocol
Negative control 1.2 mm blank disc 1.2 mm blank disc 1.2 mm blank disc
Test sample 1.2 mm sample disc 1.2 mm sample disc 1.2 mm sample disc
Positive control 3 pL of DNA Control 007 | 2 pL of DNA Control 007 | 1 yL of DNA Control 007
IMPORTANT! Do not add a blank
disc to the positive control well.

Note: If the peak heights are too high or too low for your optimized cycle number, the suggested
volumes of positive control can be adjusted.

2. Vortex the master mix and primer set for 3 seconds. Before opening the tubes or bottles, remove
droplets from the caps by briefly centrifuging the tubes or tapping the bottles on the bench.

3. Pipet the required component volumes into an appropriately sized polypropylene tube.

Component Amount per reaction
Master mix 10.0 yL
Primer set 5.0 L
Low-TE buffer 10.0 L

Note: Include volume for extra reactions to provide excess volume for the loss that occurs during
reagent transfers.

IMPORTANT! To overcome the PCR inhibition that is expected when amplifying unpurified
samples, this kit is optimized for a final PCR reaction mix volume of 25 pL. Using a lower PCR
reaction mix volume may decrease the ability of the kit chemistry to generate full STR profiles.

4. Vortex the reaction mix for 3 seconds, then briefly centrifuge.
5. Pipet 25 pL of the reaction mix into each well of a MicroAmp™ Optical 96-Well Reaction Plate.

6. Seal the plate with MicroAmp™ Clear Adhesive Film or MicroAmp™ Optical Adhesive Film.

IMPORTANT! We recommend adhesive film for plate sealing to provide a consistent seal across
all wells and prevent evaporation. Do not use caps, which may not provide a consistent seal across
all wells.
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Direct amplification: Swab substrates
7. Vortex the plate at medium speed for 3 seconds.
8. Centrifuge the plate at 3,000 x g for ~20 seconds in a tabletop centrifuge with plate holders.

Proceed to “Direct amplification: Perform PCR” on page 32.

Direct amplification: Swab substrates

Sample preparation guidelines: Swab substrate

* Detach each buccal swab head from the swab shaft before lysis.
¢ If you are using the heated lysis protocol, perform lysis in any of the following formats:
— 1.5-mL tubes with a heat block (VWR™ Scientific Select dry heat block or similar)
— PrepFiler™ 96-Well Processing Plates (Cat. No. 4392904)
— Robbins Scientific™ Model 400 Hybridization Incubator or similar
— Agilent™ Benchtop Rack for 200 pL Tubes/V Bottom Plates (metal) or similar (Cat. No. 410094)

IMPORTANT! Do not use a plastic plate adaptor.

* For optimum performance, lyse the entire swab. If you need to preserve the sample, use half of the
lysate prepared from the entire swab.

Prepare the sample lysate: Room temperature

This protocol may improve the performance of challenging or aged samples.

1. Add 400 pL of Prep-n-Go™ Buffer (Cat. No. 4471406) to 1.5-mL tubes or the appropriate wells of a
PrepFiler™ 96-Well Processing Plate (Cat. No. 4392904).

2. Place the entire head of each swab into a tube or well, then let stand for 20 minutes at room
temperature (20-25°C) to lyse the sample.

3. After 20 minutes, transfer the sample lysate into tubes or plates for storage, then discard the tubes
or plate that contain the swab heads.

Note: To minimize the risk of contamination, do not remove the swab heads from the sample
lysate before transferring the lysate.

Proceed to “Prepare the amplification kit reactions: Swab substrate” on page 30 or “Store the sample
lysate” on page 32.
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Direct amplification: Swab substrates

Prepare the sample lysate: Heat protocol

This protocol may improve the performance of challenging or aged samples.

1. Preheat the heat block to 90°C, or preheat the oven with a metal plate adaptor to 99°C.

2. Add 400 pL of Prep-n-Go™ Buffer (for buccal swabs, Cat. No. 4471406) to 1.5-mL tubes or to the
appropriate wells of a PrepFiler™ 96-Well Processing Plate (Cat. No. 4392904).

3. Into each tube or well, put the entire head of each swab. If you are using tubes, cap the tubes.
4. Let the tubes or plate stand for 20 minutes in the preheated heat block or oven to lyse the sample.

5. After 20 minutes, remove the tubes or plate from the heat block or oven, then let the lysate stand
at room temperature for =15 minutes to cool the lysate (for accurate pipetting).

6. Transfer the sample lysate to tubes or plates for storage. Discard the tubes or plate that contain the
swab heads.

Note: To minimize the risk of contamination, do not remove the swab heads from the sample
lysate plate before transferring the lysate.

Proceed to “Prepare the amplification kit reactions: Swab substrate” on page 30 or “Store the sample
lysate” on page 32.

Prepare the amplification kit reactions: Swab substrate

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer set
and allelic ladder from light when not in use.

1. Add Prep-n-Go™ Buffer (Cat. No. 4471406) to the appropriate wells of a MicroAmp™ Optical 96-
Well Reaction Plate.

Prep-n-Go™ Buffer
Control well
26-cycle protocol 27-cycle protocol 28- and 29-cycle protocols
Negative control 3L 3L 3L
Positive control — 1L 2 uL
(Do not add buffer)

2. Prepare the samples and controls as shown in the following table, then add to the appropriate
wells of a MicroAmp™ Optical 96-Well Reaction Plate.

Amount per reaction
Component

26-cycle protocol 27-cycle protocol 28- and 29-cycle protocols

Test sample 3 pL of sample lysate 3 pL of sample lysate 3 pL of sample lysate

Positive control |3 pL of DNA Control 007 |2 pL of DNA Control 007 |1 pL of DNA Control 007
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Chapter 3 Direct amplification: Perform PCR &
Direct amplification: Swab substrates

Note: If the peak heights are too high or too low for your optimized cycle number, the suggested
volumes of positive control can be adjusted.

Vortex the master mix and primer set for 3 seconds. Before opening the tubes or bottles, remove
droplets from the caps by briefly centrifuging the tubes or tapping the bottles on the bench.

Pipet the required component volumes into an appropriately sized polypropylene tube.

Component Amount per reaction
Master mix 10.0 yL
Primer set 5.0 yL
Low-TE buffer 10.0 L

Note: Include volume for extra reactions to provide excess volume for the loss that occurs during
reagent transfers.

IMPORTANT! To overcome the PCR inhibition that is expected when amplifying unpurified
samples, this kit is optimized for a final PCR reaction mix volume of 25 pL. Using a lower PCR
reaction mix volume may decrease the ability of the kit chemistry to generate full STR profiles.

Vortex the reaction mix for 3 seconds, then briefly centrifuge.

Pipet 25 pL of the reaction mix into each well of a MicroAmp™ Optical 96-Well Reaction Plate.

The final volume in each well is 28 pL (reaction mix plus Prep-n-Go™ Buffer or sample lysate or
positive control).

Seal the plate with MicroAmp™ Clear Adhesive Film or MicroAmp™ Optical Adhesive Film.

IMPORTANT! We recommend adhesive film for plate sealing to provide a consistent seal across
all wells and prevent evaporation. Do not use caps, which may not provide a consistent seal across
all wells.

Vortex the plate at medium speed for 3 seconds.

Centrifuge the plate at 3,000 x g for ~20 seconds in a tabletop centrifuge with plate holders.

Proceed to “Direct amplification: Perform PCR” on page 32.

Yfiler™ Plus PCR Ampilification Kit User Guide 31



2% Chapter 3 Direct amplification: Perform PCR
Direct amplification: Perform PCR

Store the sample lysate

1. Cap the sample lysate storage tubes or seal the sample lysate storage plate with MicroAmp™ Clear
Adhesive Film (Cat. No. 4306311).

2. Store the sample lysate as needed.

Storage time Temperature
<2 weeks 2-8°C
>2 weeks -25°C to -15°C

Note: The effects of multiple freeze/thaw cycles on the lysate have not been fully evaluated.
Therefore, multiple freeze/thaw cycles are not recommended.

Direct amplification: Perform PCR

IMPORTANT! The kit is optimized for use with the thermal cyclers that are listed in “Instruments and
software compatibility” on page 16 ..

1. Program the thermal cycler.
a. Set the ramping mode to 9600 Simulation.

b. Set the thermal cycling conditions as shown in the following table.

Optimum cycle number (26-29)["]
Initial incubation step Final extension Final hold
Denature Anneal/Extend
HOLD CYCLE HOLD HOLD
95°C 94°C 61.5°C 60°C 4°C
1 minute 4 seconds 1 minute 22 minutes <24 hoursl?

[ Determine the optimum cycle number for your laboratory according to the instructions in “(Before first use of the kit) Optimize
PCR cycle number” on page 24.

[ The infinity (c0) setting allows an unlimited hold time.
2. Load the plate into the thermal cycler, close the heated cover, then start the run.

3. When the run is complete, store the amplified DNA.

Storage time Temperature
<2 weeks 2-8°C
>2 weeks —-25°C to -15°C

IMPORTANT! Protect the amplified DNA from light.
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m Allelic ladder requirements for electrophoresis
B (Before first use of the kit) Set up the capillary electrophoresis instrument

B Prepare samples for electrophoresis and start the run

Perform electrophoresis

Allelic ladder requirements for electrophoresis

To accurately genotype samples, you must run an allelic ladder with the samples.

Number of allelic ladders

One injection

Number of samples per allelic

Lkl to run equals ladder
SegStudio™ 24 Flex Genetic |1 per injection 24 samples 23 samples + 1 allelic ladder
Analyzer
SegStudio™ 8 Flex Genetic 1 per 3 injections 8 samples 23 samples + 1 allelic ladder
Analyzer
SeqgStudio™ Genetic 1 per 6 injections 4 samples 23 samples + 1 allelic ladder
Analyzer
3500xL Genetic Analyzer 1 per injection 24 samples 23 samples + 1 allelic ladder
3500 Genetic Analyzer 1 per 3 injections 8 samples 23 samples + 1 allelic ladder

IMPORTANT! Variation in laboratory temperature can cause changes in fragment migration speed

and sizing variation between runs. Follow the guidelines in the preceding table, which should account

for normal variation in run speed. To facilitate accurate genotyping of all samples in your laboratory

environment, perform internal validation studies to verify the required allelic ladder injection frequency.

It is critical to genotype using an allelic ladder that is run under the same conditions as the samples.

Size values obtained for the same sample can differ between instrument platforms because of different

polymer matrices and electrophoretic conditions.
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(Before first use of the kit) Set up the capillary electrophoresis instrument

(Before first use of the kit) Set up the capillary
electrophoresis instrument
Data collection software setup

To analyze PCR products generated by the kit, you can use the data collection software and run
parameters provided in this section. See the appropriate table for your instrument.

Note: Individual CE instrument signal intensities can vary; therefore, changes to injection parameters
may need to be explored and validated to deliver the best results on your system. Large deviations
from the recommended injection parameters can affect the performance of the size standard and allelic
ladder, therefore validation is recommended.

Note: For detailed procedures, see the appropriate user documentation for your instrument.

Table 1 Software setup: SeqStudio™ Flex Series Genetic Analyzer for Human Identification

SeqStudio™ Flex Data

Collection Software (Optional) Additional software Run parameters

vi.1.1 * SAE Administrator Console v2.1 | |njection protocol: HID_Protocol_J6_36_POP4(xI)

* SeqStudio™ Plate Manager

Software v2.1, v2.1.1 Size standard: GS600 LIZ (60-460)

* SeqStudio™ Flex Remote Dye set: J6 (DS-36)

Monitoring Software
Run module: HID_J6_36_POP4 (xI)

Injection conditions: 1.2 kV/15 seconds (xI:
24 seconds)

Run conditions: 13 kV/1,550 seconds

Table 2 Software setup: SeqStudio™ Genetic Analyzer for HID

SeqStudio™
Data Collection (Optional) Additional software Run parameters Plate setup
Software
v1.2.1,v1.2.4, * SAE Administrator Console v2.0, Run Module: HID Analysis Kit: Yfiler™ Plus kit
v1.2.5 v2.1 T .
« SeqgStudio™ Plate Manager Software Injection conditions: Dye set: J6 (DS-36)
1.2 kV/10 seconds
vi.2, vi1.3

Run conditions: Size standard:
11 kV/1,120 seconds GS600 LIZ (60-460)
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(Before first use of the kit) Set up the capillary electrophoresis instrument

Table 3 Software setup: 3500 Series Genetic Analyzer for Human Identification

3500 Data Collection

Operating system Software

Run parameters

Windows™ 10 v4, v4.0.1 Assay: AB_J6_LS_POP4(xI)

Instrument protocol: AB_HID36_POP4(xl)_J6_NT3200

Run module: HID36_POP4(xI)

Injection conditions: 1.2 kV/16 seconds (xI: 24 seconds)!'!

Alternate injection conditions: 1.5 kV/16 seconds (xl:
24 seconds)

Run conditions: 13 kV/1,550 seconds

Dye set: J6

M This kit was developed using an injection time of 16 seconds on the 3500 instrument. This is different from the default injection time of
15 seconds. You will need to change the instrument protocol accordingly.

@ This kit was developed using two injection voltage conditions for the 3500 instrument: 1.2 kV/16 seconds and 1.5 kV/16 seconds. You are
encouraged to explore both options during validation to determine which protocol provides the best results on your instrument.

Perform spectral calibration

Perform a spectral calibration using the DS-36 Matrix Standard Kit (Dye Set J6, 6-dye)
(Cat. No. 4425042).

Examples of spectral calibrations are shown in this section. See the appropriate figure for your
instrument.
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(Before first use of the kit) Set up the capillary electrophoresis instrument

J6 (DS-36) Spectral Calibration

Dye Matrix

Result Spectral QV Condition number Borrowed

Figure 3 Example spectral calibration: SeqStudio™ Flex Series Genetic Analyzer for Human Identification
J6 (DS-36)™

Dye Matrix

Figure 4 Factory-provided spectral calibration: SeqStudio™ Genetic Analyzer for HID
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Figure 5 Example spectral calibration: 3500 Series Genetic Analyzer for Human Identification

Prepare samples for electrophoresis and start the run

Prepare the samples for electrophoresis immediately before loading.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect the primer set,
amplified DNA, allelic ladder, and size standard from light when not in use.

1. Pipet the required component amounts into an appropriately sized polypropylene tube.

Component Amount per reaction
GeneScan™ 600 LIZ™ Size Standard v2.0 0.4 pL
Hi-Di™ Formamide 9.6 uL

Note: Include additional samples in your calculations to account for the loss that occurs during
reagent transfers.

IMPORTANT! The amount of size standard indicated in the table is a suggested amount.
Determine the appropriate amount of size standard based on your experiments and results.

2. Vortex the tube, then briefly centrifuge.
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Prepare samples for electrophoresis and start the run

3. Pipet the required component amounts into each well of a MicroAmp™ Optical 96-Well Reaction

Plate.

Component Amount per reaction
Formamide/size standard mixture 10 pL
PCR product or allelic ladder 1L

Note: For blank wells, add 10 yL of Hi-Di™ Formamide.

4. Seal the reaction plate with appropriate septa, then briefly vortex and centrifuge the plate to ensure
that the contents of each well are mixed and collected at the bottom.

5. Heat the reaction plate in a thermal cycler for 3 minutes at 95°C.
6. Immediately place the plate on ice for 3 minutes.

7. Place the sample tray on the autosampler, then start the electrophoresis run.
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Overview of GeneMapper™ ID-X Software

GeneMapper™ ID-X Software is an automated genotyping software application for forensic casework,
databasing, and paternity data analysis.

After capillary electrophoresis, the data collection software stores information for each sample in a FSA
or HID file. The GeneMapper™ ID-X Software allows you to analyze and interpret the data from the FSA
or HID files.

Note: For a list of GeneMapper™ ID-X Software versions that are compatible with your kit and capillary
electrophoresis instrument, see “Instruments and software compatibility” on page 16 .
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Allelic ladder requirements for data analysis

Allelic ladder requirements for data analysis

HID analysis requires at least one allelic ladder sample per run folder. Perform the appropriate
internal validation studies before you use multiple allelic ladder samples in an analysis.

For multiple allelic ladder samples, the GeneMapper™ ID-X Software calculates allelic bin offsets by
using an average of all allelic ladders that use the same panel in a run folder.

Allelic ladder samples in an individual run folder are considered to be from a single run. When the
software imports multiple run folders into a project, only the ladders in their respective run folders
are used for calculating allelic bin offsets and subsequent genotyping.

Allelic ladder samples must be labeled as "Allelic Ladder" in the Sample Type column in a project.
Analysis will fail if the Allelic Ladder Sample Type is not specified.

Injections containing the allelic ladder must be analyzed with the same analysis method and
parameter values that are used for samples, to help ensure proper allele calling.

Alleles that are not in the allelic ladders do exist. Off-ladder (OL) alleles can contain full and/or
partial repeat units. An off-ladder allele is an allele that occurs outside the bin window of any
known allelic ladder allele or virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, verify the sample result according to
your laboratory protocol.

File names and versions used in this section

40

The file names and version numbers of panel, bin, and stutter files that are shown in this section may
differ from the file names that you see when you download or import files.

If you need help to determine the correct files to use, contact your local Human Identification
representative, or go to thermofisher.com/support.
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Set up the GeneMapper™ ID-X Software for analysis (before first use of the kit) ="

Set up the GeneMapper™ ID-X Software for analysis (before
first use of the kit)

Workflow

Before you use GeneMapper™ ID-X Software to analyze data for the first time, you must do the
following:

Set up GeneMapper™ ID-X Software

. Check panel, bin, and stutter file versions on your computer
. (If needed) Download newer versions of panel, bin, and stutter files
(If needed) Import panels, bins, and marker stutter

(Optional) Define custom table or plot settings

Check panel, bin, and stutter file versions on your computer

1. Start the GeneMapper™ ID-X Software, then sign in with the appropriate user name and password.

2. Select Tools » Panel Manager.

®

Check the version of files that are currently available in the Panel Manager.
a. Select Panel Manager in the navigation pane.

¥ Panel Manager - .4
File Edit Bins Vi Hel
b. Expand the Panel Manager folder and any == - m 'TN =
subfolders to identify the analysis file version that X |Iife = ai
is already installed for your kit choice. +=« PNl Manager

4. Check the version of files available for import into the Panel Manager.
a. Select Panel Manager, then select File » Import Panels to open the Import Panels dialog
box.

b. Navigate to the Panels folder, then check the version of panel, bin, and stutter files installed.
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Set up the GeneMapper™ ID-X Software for analysis (before first use of the kit)

GeneMapper™ ID-X Software v1.7.x contains the latest panel, bin, and stutter files for the STR Kkits.

¢ |[f the latest files are not installed on your copy of the GeneMapper™ ID-X Software, proceed to “(If
needed) Download newer versions of panel, bin, and stutter files” on page 42.

* |[f the latest files are already installed on your copy of the GeneMapper™ ID-X Software, skip to
“Create an analysis method” on page 47.

(If needed) Download newer versions of panel, bin, and stutter files

1. Go to www.thermofisher.com/GMIDXsoftware.

The page provides a list of kit-specific analysis files. The analysis files for each kit can be
downloaded in a single ZIP file.

2. If the analysis file versions listed for your kit are newer than the versions on your computer,
download the ZIP file.

Note: When downloading new versions of analysis files, see the associated Read Me file for
details of changes between software file versions. Perform the appropriate internal validation
studies before using new file versions for analysis.

3. Unzip the file.

(If needed) Import panels, bins, and marker stutter

Import the latest panel, bin set, and marker stutter from the website into the GeneMapper™ ID-X
Software database.

Note: The file names specified in this procedure are examples only. The files that you import may have
different file names.

1. Start the GeneMapper™ ID-X Software, then sign in with the appropriate user name and password.
2. Select Tools » Panel Manager.

3. Open the folder that contains the panels, bins, and marker stutter.

a. Select Panel Manager, then select File » Import Panels to open the Import Panels dialog
box.

b. Navigate to the analysis files folder that you unzipped in “(If needed) Download newer
versions of panel, bin, and stutter files” on page 42.
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Set up the GeneMapper™ ID-X Software for analysis (before first use of the kit) =~

4. Select the panels TXT file for your kit, then click Import.

4? Import Panels X

oo
o0

Look In: Iﬁ Panels

[} AmpFLSTR_Bins_v7X.txt
() AmpFLSTR_Panels_v7X.txt
) AmpFLSTR_Stutter_v7X.txt

File Name:  [AmpFLSTR_Panels_v7X.td |

Files of Type: |All Files v

I Import || Cancel |

Importing the panels TXT file creates a new folder in the navigation pane of the Panel Manager.
This folder contains the panels and associated markers.

5. Import the bins file.
a. In the navigation pane, select the panel folder created in step 4.

4? Panel Manager

File Edit Bins View Help

Bin Set: |AmpFLSTR_Bins_v7X |v| @

% ahnPanel Manager i |l (B

L& AmpFLSTR_Panels_v7X Glohalfiler-1QC_Fanel_jnull

o [ SeqStudio_Panels_v7X GInbaIFiIer_Ex;ress_v null
GlabalFiler_Fanel_v1.2 null
Yhiler_Plus_Panel_v4.2 | null
MGM_Detect_Fanel_w: | null
WeriFiler_Express_Far | null
|dentifiler_Plus_v1 8% |null
[dentifiler_Direct_w1 6% null

@ |~ o [ =] =

b. Select File » Import Bin Set to open the Import Bin Set dialog box.

c. Navigate to the analysis files folder for your kit (from step 3).
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T Set up the GeneMapper™ ID-X Software for analysis (before first use of the kit)

d. Select the bins TXT file for your kit, then click Import.

¥ Import Bin Set x

LookIn: |3 Panels b

[} AmpFLSTR_Bins_v7X.txt
[} AmpFLSTR_Panels_v7X.txt
|j| AmpFLSTR_Stutter_v7X.txt

File Mame: |AmpFLSTR_EI‘ins_vTX.m |

Files of Type: |All Files [~]

Import Cancel

Importing the bins TXT file associates the bin set with the panels imported in step 4.

6. (Optional) View marker and panel information: In the navigation pane, select the panel folder for
your kit.

The panel information is displayed in the right pane and the markers are displayed below it.

4* Panel Manager X
File Edit Bins View Help
i Bin Set [AmpFLSTR_Bins_v7x [~ =
o~ ) ClobalFiler_Panel_vi2X  |&| | b Hene Dye Colar |3 Sim | Max Size  Covrol Allles Micker | Comments ¥ Makear |Tumal QC PAT  |Hamosyes Heeozrgo M PER
_Panel_\ | |1 prsare Blus |58.0 [1380 |19 4 |none =] ] 00 Joo [oo oo
o INGM_Detect_Panel_va.1x | | |2 |Dvs3eal Bluz  [1420 [1840 |13 4 |none o | 00 |00 |00 o0
o [ veriFiler_Express_Panels_vd | |3 |Dvse3s Bluz  |1870 (2570 |24 4 |none o | 00 |00 |00 o0
o~ Didentifiler_Plus_v1 6X 4 |Dvs3sal Blue [2602 |[3142 |29 4 |none [m] O 00 |00 |00 |00
¢ Odentfler Direct v18X | | o pvassr Blue |3195 |3235 |21 ¢ |none FRNIE 00 |00 o0 (oo
I gﬂz":";ggiéwms e | |6 [ovsasn Green |751 [1131 11 4 |none o o 00 |00 |00 o0
L EINCM_SHedZEX [7[prsass Green [1160 1770 |17 4 |none o o 00 |00 |00 oo
o ) VAler v 5% | | [ [ovsta Green |1785 2208 |15 4 |none o | 0o |00 |oo oo
o EINGM_v3.6X |o [vGaTAHE  |Green |2314 2694 |13 4 |none == 00 |00 |00 o0
o CDidentifiler_v1.6X [10|Dvs428 Green [2712 (3452 |19 & |none O | 00 |00 |00 o0
o E)Identifiler_CODIS_v1.6X [11|ovsaer Graen [3485 [4025 11 4 |none o | 00 |00 |00 oo
o [EDProfiler_Plus_v1.6X |12|ovsass Vellow |710  [1350 |15 4 |none o | 00 |00 |00 o0
o [DProfiler_Plus_CODIS_v1.6X | [13|ovs300 vellow |1392 [197.2 |24 4 |none [m] O 00 |00 |00 |00
T T——] K D Vellow |2015 [2635 |12 5 |none o | 00 |00 |00 oo
A 46 DYE302 Vellow (2700 |3268 |12 3 |none O | 00 |00 |00 o0
saReference Samples DYs518 Yellow |3278 |4060 |37 4 |none o o 00 oo |00 (oo
[17|ovesTo Red |035  |1678 |17 4 |none o o 00 |00 |00 oo
[18|Dvaazz Red  [1733 |2153 |15 & |none SENIE 0o |00 |oo oo
[10|Dvs385 Red  |2204 |3184 11,14 4 |none == 00 |00 |00 o0
|20|Dvsa48 Red  [3208 (4030 |30 4 |none O | 00 |00 |00 o0
|21|ovs3a3 Pumple (3536 |130.36 |13 4 |none o | 00 |00 |00 o0
|22|ovsa39 Pumple [1456 |1996 |12 4 |none o | 00 |00 |00 o0
|23|ovaaat Pumple [2030 (2560 |22 3 |none o |3 00 |00 |00 o0
|2a|DvFa878T  |Pumle 2594|3250 (35,37 4 |none O | 00 |00 |00 o0
|25|Dvesaz Pumple [3338 (3830 |13 4 |none = 00 |00 |00 o0
1 |l T [»]
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Set up the GeneMapper™ ID-X Software for analysis (before first use of the kit) ="

7. Import the stutter file.

a. In the navigation pane, select the panel folder for your kit.

b. Select File » Import Marker Stutter to open the Import Marker Stutter dialog box.
c. Navigate to the analysis files folder for your kit (from step 3).

d. Select the stutter TXT file for your kit, then click Import.

2? Import Marker Stutter x

Look In: | Panels - @ @ E

[} AmpFLSTR_Bins_v7X.txt
[} AmpFLSTR_Panels_v7X.txt
[} AmpFLSTR_Stutter_v7X.txt

File Mame: |.n.mpFLSTR_Stuﬁer_u?}(.bd |

Files of Type: |AII Files |v|

Import Cancel

Importing the stutter TXT file associates the marker stutter ratio with the bin set in the panel

folder for your kit (step 4) and overwrites any existing stutter ratios associated with the panels
and bins in that folder.

8. (Optional) View the imported marker stutters.

a. In the navigation pane, click the panel folder for your kit to expand it.
The markers are displayed in the navigation pane.
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"5 Set up the GeneMapper™ ID-X Software for analysis (before first use of the kit)

b. Double-click a marker, then select the Stutter Ratio & Distance view for the marker in the
right pane.

Note: The allele-specific stutter fields shown in the image are not implemented in
GeneMapper™ ID-X Software v1.6 and earlier.

4* Panel Manager X
File Edit Bins View Help
Bin Set | AmpFLSTR_Bins_v7X |VI ‘@,‘
(C3Yfiler_Plus_Panel_v4.2X = ) . ’
t o DYss?6 - m Please enter the stutter filter(s) for DYS576 marker here If left blank, the global stutter filter will be applied.
Stutter Ratio & Distance il i
Marker thresholds Marker Level Minus Stutter Marker Level Plus Stutter
: B::gz:l Ratio From Distance  |To Distance Ratio From Distance  |To Distance
- 151 . 47 . .
o DYa3s0l 1 0.1515 3.25 4 1 0.0338 |325 475
o DYS627 2 2
o DYS480 3 3
o= DYS458 4 4
f~ DYs19 ‘ New ‘ Edit H Delete I
o YGATAH4
o= DYS448
o= DYS391
o= DYS456
<| > e 57| | Allele-Specific Minus Stutter Allele-Specific Plus Stutter
.4 Ratio From Distance |To Distance Allele Ratio From Distance |To Distance Allele
s, Reference Samples 1 1 |
2 2
3 3
4 4
‘ New ‘ Edit l ‘ Delete l

9. Click Apply, then click OK to add the panel, bin set, and marker stutter to the GeneMapper™ ID-X
Software database.

IMPORTANT! If you close the Panel Manager without clicking Apply, the panels, bin sets, and
marker stutter are not imported into the GeneMapper™ ID-X Software database.

(Optional) Define custom table or plot settings

Default views for table and plot settings are provided with the software.

For information on defining custom views, see GeneMapper™ ID-X Software v1.5 Getting Started Guide
— Basic Features.
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Create an analysis method

Create an analysis method

IMPORTANT! Because analysis methods are version-specific, you need to create an analysis method
for each version of the software. For example, an analysis method that is created in GeneMapper™ ID-X
Software v1.6 is not compatible with analysis methods that are created in v1.5 or v1.7.x.

1. Select Tools » GeneMapper ID-X Manager to open the GeneMapper ID-X Manager.

L4 GeneMapper™ ID-X Manager X
Find Name Containing: ||
Projects Analysis Methods  Table Settings Plot Settings Matrices Size Standard Report Setti

Project Last Saved Owner # of Samples Description

Test1 2023-12-1912:17 | gmidx 14

Test2 2023-11-02 10:5° | gmicx 4

Import...
Help Done

2. Click the Analysis Methods tab, then click New to open the Analysis Method Editor with the
General tab selected.

3. Enter the settings as described in the following pages.

Note: The Analysis Method Editor closes when you save the settings. To complete this step
quickly, do not save the analysis method until you finish entering the settings in all tabs.

4. After you enter the settings on all tabs, click Save.

Enter Analysis Method settings

Enter General tab settings

1. Enter an analysis method name.
2. Select the security group appropriate for your software configuration.

3. (Optional) Enter a description and an instrument.
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Create an analysis method

4? Analysis Method Editor

[ General | Allele | Peak Detector | Peak Quality | SQ& GQ Settings |

~Analysis Method Description

Mame:

IMy_Analysis_Method

Security Group: |GeneMapper ID-X Security Group

Description:

<[l »

Instrument:

Analysis Type: HID

Save

Cancel

Help

Figure 6 General tab settings
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Enter Allele tab settings

Chapter 5 Analyze data with GeneMapper™ ID-X Software

Create an analysis method

K

IMPORTANT! Perform internal validation studies to determine the appropriate settings for your

laboratory.

1. Select the appropriate bin set.

2. (Optional) Select stutter options.

Option

Action

Additional information

Use marker-specific stutter ratio and distance if
available

Select or deselect the

checkbox, as needed.

To apply the stutter ratios that are
contained in the Panel Manager,
select the checkbox.

Use allele-specific stutter ratios and distances if
available

The checkbox is available only for GeneMapper™
ID-X Software v1.7 or later.

Select or deselect the

checkbox, as needed.

To use allele-specific stutter filtering,

select the checkbox.

Consider additive stutters (forward and back)

The checkbox is available only for GeneMapper™
ID-X Software v1.7 or later.

Select or deselect the

checkbox, as needed.

To take additive stutter into
consideration, select the checkbox.

Note: For more information on the GeneMapper™ ID-X Software v1.7 options, see the
GeneMapper™ ID-X Software v1.7 New Features and Software Verification and Validation User

Bulletin (Pub. No. MAN0029209).

3. In the Marker Repeat Type pane, enter values for the Tri, Tetra, Penta, and Hexa loci.

Note: For paternity and database applications: In the Global Cut-off Value field, we
recommended using a cut-off value of 20% for the Tri, Tetra, and Penta loci.

4. Enter the appropriate filter settings.
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Chapter 5 Analyze data with GeneMapper™ ID-X Software

Create an analysis method

4? Analysis Method Editor X
[ General | Allele | Peak Detector | Peak Quality | SQ & GQ Settings |
oin et [AmPFLSTR Bims /X v
Use marker-specific stutter ratio and distance if available
|:| U=se allele-zpecific stutter ratioz and distances if available.
|:| Consider additive stutters (forward and back).
Marker Repeat Type: Tri Tetra Penta Hexa
Global Cut-off Value o | oo | oo | [oo |
MinusA Ratio o | [po | oo | [oo |
MinusA Distance From (00 | foo | foo | Joo |
To o0 | oo | Joo | Joo |
Global Minus Stutter Ratio o | [po | oo | [oo |
Global Minus Stutter Distance  From (00 | [325 | o0 | [o0 |
To oo | |a75 | Joo | Joo |
Global Plus Stutter Ratio o | oo | oo | [oo0 |
Global Plus Stutter Distance  From [00 | oo | oo | [oo |
To oo | foo | Joo | foo |
Amelogenin Cutoff  |0.0
Range Filter... Factory Defaul...
Save Cancel Help

Figure 7 Allele tab settings
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Enter Peak Detector tab settings

Enter or select the appropriate values.

=]

<
|~ ]

Chapter 5 Analyze data with GeneMapper™ /ID-X Software
Create an analysis method

Option

Action

Additional information

Use marker-specific
thresholds (if available)
The checkbox is available
only for GeneMapper™ ID-X
Software v1.7 or later.

Select or deselect the
checkbox, as needed.

To use the marker-specific thresholds defined in the Panel
Manager, select the checkbox.

Ranges

Analysis—Select Full
Range from the
dropdown list.

(if needed) The analysis range can be narrowed.

Sizing—Select All
Sizes from the
dropdown list.

Smoothing and Baselining

Smoothing—Select
Light.

Baseline Window —
Enter 33 pts.

The Yfiler™ Plus kit was validated with the values listed.

If your laboratory uses an unvalidated polymer, you may
need to adjust these values.

Size Calling Method

Select 3rd Order Least
Squares or Local
Southern Method.

The Yfiler™ Plus kit was validated using the 3rd Order Least
Squares and Local Southern Method.

Do not select another method unless you perform internal
validation studies to determine the appropriate method for
your laboratory.

Peak Detection

Peak
Amplitude Thresholds
—User-defined.

The default value is 50 RFU for all dyes.

Perform internal validation studies to determine the
appropriate peak amplitude thresholds for your laboratory.

Min. Peak Half Width—
Enter 2 pts.

Polynomial Degree—
Enter 3.

Peak Window Size—
Enter 13 pts.

Slope Threshold

Peak Start—Enter 0.0.

Peak End—Enter 0.0.

The Yfiler™ Plus kit was validated with the values listed.
Do not enter other values unless you perform internal
validation studies to determine the appropriate values for
your laboratory.
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Create an analysis method

(continued)

Option Action Additional information
Use Normalization, if Select or deselect the | To apply size standard normalization data to the analysis,
applicable checkbox, as needed. | select the checkbox.
The checkbox is available The size standard normalization data are collected on the
for use with data run on the capillary electrophoresis instrument. To see if normalization
following instruments: data have been collected for a specific data file, see SS

¢ SeqStudio™ Flex Series Normalization Factor in the GeneMapper™ ID-X Software.

Genetic Analyzer for
Human Identification

® 3500 Series Genetic
Analyzer for Human
Identification
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Create an analysis method T4

4? Analysis Method Editor x

[ General | Allele | Peak Detector | Peak Quality | SQ & GQ Settings

Peak Detection Algorithm: Advanced

I:] Use marker-specific thresholds (if available).

Ranges Peak Detection
Analysis Sizing Peak Amplitude Thresholds:
FullRange | v | |Al Sizes v & | R | |
Start Pt Start Size
s G | P | |
Stop Pt Stop Size
Y| jo: | |

~ Smoothing and Baselining

Smoothing ) Mone

@ Light Min. Peak Half Width: |2 =
) Heawy Polynomial Degree: |3
Baseline Window: 33 pts Peak Window Size: |13 |pts

e apr Slope Threshold
tze L-afiing Hetho Peak Start 0.0
i) 2nd Order Least Squares
i) 3rd Order Least Squares Peak End: 0.0

i) Cubic Spline Interpolation N lizati
i® Local Southern Method ormaiization

(. Global Southern Method [ ] use Normalization, if applicable
Factory Defaults
Save As Save Cancel Help

Figure 8 Peak Detector tab settings

Enter Peak Quality tab settings

1. Perform internal validation studies to determine the heterozygous and homozygous minimum peak
height thresholds, maximum peak height threshold, and the minimum peak height ratio threshold
for interpretation of data.

2. For the remaining fields, enter the values shown in Figure 9.

Note: The Pull-Up Ratio (PU) settings shown in the figure are implemented only in GeneMapper™
ID-X Software v1.7 or later. For more information on these settings, see the GeneMapper™

ID-X Software v1.7 New Features and Software Verification and Validation User Bulletin

(Pub. No. MAN0029209).
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Create an analysis method

at Analysis Method Editor

Min/Max Peak Height (LPH/MPH})
Homozygous min peak height

Heterozygous min peak height
Max Peak Height (MPH)

Peak Height Ratio (PHR)
Min peak height ratio

Broad Peak (BD)
Max peak width (basepairs)

Allele Number (AN)

Max expected alleles:
For autosomal markers & AMEL
For Y markers

Allelic Ladder Spike

70U LU

Spike Detection

|Enable |

Al

Cut-offvalue

Sample Spike Detection

0.2

Spike Detection

|Enable |

L

Pull-Up Ratio {PU)

|:| Enable pull-up detection.
@ Label pull-up

{_ Remove pull-up peaks

Max pull-up ratio

Pull-up offset (data points)

05

I

|/General |/ Allele r Peak Detector |T Peak Quality r 50 & GQ Settings

Save As Save

Cancel

Help

Figure 9 Peak Quality tab settings

Enter SQ & GQ tab settings

Enter the appropriate values.

IMPORTANT! The software default values are shown in Figure 10. We used the software default
values during developmental validation. We recommend that you perform internal validation studies to

determine the appropriate values for your laboratory.
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(If needed) Create a size standard definition file

4? Analysis Method Editor X

[ General | Allele | Peak Detector | Peak Quality | SQ & GQ Settings |

Quality weights are between 0 and 1.
- Sample and Control GQ Weighting

Broad Peak (BD) 0.8 Allele Mumber (AN) 1.0
Out of Bin Allele (BIMN) 0.8 Low Peak Height (LPH) 0.3
Overlap (OVL) 0.8 Max Peak Height (MPH)} 0.3
Marker Spike (SPK) 03 Off-scale (0OS) 08
AMEL Cross Check (A... |0.0 Peak Height Ratio (PH... |0.3
Control Concordance (CC) Weight = 1.0 {Only applicable to controls)

- S0 Weighting
Broad Peak (BD) 05

~Allelic Ladder GQ Weighting

<

Spike (SSPKISPK) Off-scale (0OS)

£

- 5Q & GQ Ranges

Sizing Quality: From |0.75 to1.0 From00to |0.25
Genotype Qualityy.  From |0.75 to1.0 From00to |0.25

Reset Defaults

Save Cancel Help

Figure 10 SQ & GQ tab settings

(If needed) Create a size standard definition file

If you cannot use the default settings that are provided, create a new size standard definition file.
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(If needed) Create a size standard definition file

About the GS600_LIZ_(60-460) size standard definition file

The GS600_LIZ_(60-460) size standard definition file that is provided with GeneMapper™ ID-X Software
and used with the Local Southern Method (size calling method) contains the following peaks: 60, 80,
100, 114, 120, 140, 160, 180, 200, 214, 220, 240, 250, 260, 280, 300, 314, 320, 340, 360, 380, 400,
414, 420, 440, and 460.

This size standard definition has been validated for use with this kit on the genetic analyzers listed in
“Instruments and software compatibility” on page 16 . If you need to create your own size standard
definition, see “Create a size standard definition file” on page 56.

Create a size standard definition file
1. Select Tools » GeneMapper ID-X Manager to open the GeneMapper ID-X Manager.

2. Click the Size Standards tab, then click New.

o GeneMapper™ ID-X Manager X

Find Name Containing:

Projects  Analysis Methods  Table Settings  Plot Settings  Matrices  Size Standards  Report Settings

MName Last Saved Owner Type Description
CE_F_HID_GS500 (75-400) 2007-08-09 21:23:52.288  |gmidx Advanced | |
CE_F_HID_GS500 {75-450) 2007-08-09 21:24:09.052 gmidx Advanced

CE_G5_HID_GS500 2008-10-11 21:12:27.0 gmidx Advanced

GSE00_LIZ 2007-06-26 18:43:19.0 gmidx Advanced
GS600_LIZ+Normalization_(60-460) 2012-08-06 20:37:29.049 gmidx Advanced =
GSB00_LIZ+Normalization_(80-400) 2012-08-06 20:37:37.785 gmidx Advanced

GS600_LIZ_(60-460) 2012-08-06 20:21:32.24 grmidx Advanced

GS600_LIZ_{80-400) 2007-06-27 09:43:19.0 gmidx Advanced
RapidHITID_GS600_Size_Standard 2022-09-08 231174673 gmidx Advanced |
RapidHITID_SS3_Size_Standard 2018-10-05 10:02:10.807 gmidx Advanced i

Lt

Import...

| tep || gone |

3. Specify settings in the Size Standard Editor.
a. Enter a name.

b. In the Security Group field, select the security group appropriate for your software
configuration.

c. In the Size Standard Dye field, select Orange.
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(If needed) Create a size standard definition file ="

d. In the Size Standard Table, enter the peak sizes that correspond to your size standard. (If
needed) Click Insert to add rows or click Delete to remove rows.

4 Size Standard Editor >
Edit
- Size Standard Description
Mame: My_Size_Stan dard|

Security Group: GeneMapper ID-X Security Group -

Diescription:

Size Standard Diye: Orange -

r Size Standard Table
Size in Basepairs
1 0.0

Insert Delete

0o

[ m -|T|_

0o

0o

0.0

0o

= | | n| s | M

0o

L4 ]

oK Cancel Help
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Analyze and edit sample files with GeneMapper™ ID-X Software

Analyze and edit sample files with GeneMapper™ ID-X
Software

1. In the Project window, select Edit » Add Samples to Project, then navigate to the disk or
directory that contains the sampile files.

2. Apply analysis settings to the samples in the project.

Option Action

Sample Type Select the sample type for each sample, control, and allelic ladder in the project.

Analysis Method | Select the analysis method that you created in “Create an analysis method” on
page 47.

Panel Select the current kit panel. If needed, see “Check panel, bin, and stutter file
versions on your computer” on page 41.

Size Standard Select the GS600_LIZ_(60-460) size standard definition, or select another validated
size standard definition, as described in “(If needed) Create a size standard
definition file” on page 55.

3. Click Analyze.

4. In the Save Project dialog box, enter a name for the project, then click OK to start analysis.
* The status bar displays the progress of analysis.

* The table displays the row of the sample currently being analyzed in green (or red if analysis
failed for the sample).

* The Analysis Summary tab is displayed, and the Genotypes tab is available when the
analysis is complete.

Examine or edit a project

Display electropherogram plots from the Samples and Genotypes tabs of the Project window to
examine the data.

For more information on using the GeneMapper™ ID-X
Software

See “Related documentation” on page 127 for a list of available documents.
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Importance of validation

Validation of a DNA typing procedure for human identification applications is an evaluation of the
efficiency, reliability, and performance characteristics of the procedure. By challenging the procedure
with samples that are commonly encountered in forensic and parentage laboratories, the validation
process uncovers attributes and limitations that are critical for sound data interpretation (Sparkes,
Kimpton, Watson, 1996; Sparkes, Kimpton, Gilbard, 1996; Wallin, 1998).

Experiment conditions

We conducted developmental validation experiments according to the updated and revised guidelines
from the Scientific Working Group on DNA Analysis Methods (SWGDAM, December 2012). Based on
these guidelines, we conducted experiments that comply with guidelines 2.0 and 3.0 and its associated
subsections. This DNA methodology is not novel. (Moretti et al., 2001; Frank et al., 2001; Wallin et al.,
2002; and Holt et al., 2000).

We used conditions that produced optimum PCR product yield and that met reproducible performance
standards. It is our opinion that while these experiments are not exhaustive, they are appropriate for a
manufacturer of STR kits intended for forensic and/or parentage testing use.
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Laboratory requirements for internal validation

Laboratory requirements for internal validation

Each laboratory using this kit must perform internal validation studies. Performance of this kit is
supported when used according to the following developmentally validated parameters. Modifications
to the protocol should be accompanied by appropriate validation studies performed by the laboratory.

Developmental validation

Except where noted, all developmental validation studies were performed using the Veriti™ Thermal
Cycler according to the protocol described in the Perform PCR chapter.

SWGDAM guideline 2.2.1

“Developmental validation is the acquisition of test data and determination of conditions and limitations
of a new or novel DNA methodology for use on forensic, database, known or casework reference
samples.” (SWGDAM, December 2012)

SWGDAM guideline 3.9.2

“The reaction conditions needed to provide the required degree of specificity and robustness should
be determined. These include, but are not limited to, thermal cycling parameters, the concentration

of primers, magnesium chloride, DNA polymerase, and other critical reagents.” (SWGDAM, December
2012)

PCR components

We examined the concentration of each component in the kit. We established that the concentration
of each component was within the range where data indicated that the amplification met the required
performance criteria for specificity, sensitivity, and reproducibility.

For example, blood and buccal samples on treated-paper substrates or swab-sample lysates were
amplified in the presence of varying concentrations of magnesium chloride, and the results were
analyzed on a 3500xL Genetic Analyzer. The performance of the multiplex is most robust within +£20%
of the optimal magnesium chloride concentration.
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Developmental validation
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Figure 11 Electropherogram obtained from the amplification of a mixture of 1 ng of male DNA Control 007 and
1 pg of female Control DNA 9947A with varying concentrations of magnesium chloride analyzed on a 3500xL

Genetic Analyzer (Y-axis scale 0-13,000 RFU).
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Figure 12 Electropherogram obtained from the amplification of a blood sample on an FTA™ card amplified with
the Yfiler™ Plus kit in the presence of varying concentrations of magnesium chloride and analyzed on a 3500xL

Genetic Analyzer (Y-axis scale 0-10,000 RFU).

Yfiler™ Plus PCR Amplification Kit User Guide

61



|I|."é;~*a‘-

Chapter 6 Experiments and results
Developmental validation

Mark Sample for Deletor

10 = m 0 30 0

-20%
T R Y || Y NI

Mark Sample for Deletor

I T T Y I TR TN U e [

Mark Sample for Deletor

Optimal

I T | T T Ll |

Mark Sample for Deletor

=L | [T 1 I Ll L/
EI [ I TR T Ll

=

+20%

Figure 13 Electropherograms obtained from the amplification of a buccal sample on an FTA™ card amplified with
the Yfiler™ Plus kit in the presence of varying concentrations of magnesium chloride and analyzed on a 3500xL
Genetic Analyzer (Y-axis scale 0-20,000 RFU).

Thermal cycling temperatures

62

Thermal cycling parameters were optimized using a Design of Experiments (DOE) approach that
attempts to identify the combination of temperatures and hold times that produce the best assay
performance. Optimal assay performance was determined through evaluation of assay sensitivity, peak-
height balance, and resistance to PCR inhibitors.

The denaturation temperatures tested were 93°C, 94°C, and 95°C, all for 4-second hold times on the
Veriti™ Thermal Cycler. The annealing temperatures tested were 60.5, 61, 61.5, 62, and 62.5°C, for
1-minute hold times in the Veriti™ Thermal Cycler. The PCR products were analyzed using the 3500xL
Genetic Analyzer.

No preferential amplification was observed in the denaturation temperature experiments. Of the tested
annealing temperatures, 61°C, 61.5°C, and 62°C produced robust profiles with no significant cross
reactivity to 1 pg of female DNA. At 62.5°C, the yield of most loci was reduced. This poses no problem
with routine thermal cycler calibration and when following the recommended amplification protocol.
Preferential amplification was not observed at the standard annealing temperature of 61.5°C.
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Figure 14 Electropherogram obtained from the amplification of a mixture of 1 ng of male DNA Control
007 and 1 pg of female Control DNA 9947A with varying annealing temperatures analyzed on a 3500xL

Genetic Analyzer (Y-axis scale 0-8,000 RFU).
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Figure 15 Electropherogram obtained from the amplification of a mixture of a blood sample on an
FTA™ card with varying annealing temperatures analyzed on a 3500xL Genetic Analyzer (Y-axis scale

0-12,000 RFU).
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Figure 16 Electropherogram obtained from the amplification of a mixture of a buccal sample on an
FTA™ card with varying annealing temperatures analyzed on a 3500xL Genetic Analyzer (Y-axis scale
0-10,000 RFU).

Accuracy, precision, and reproducibility

SWGDAM guideline 3.5

“Precision and accuracy of the assay should be demonstrated: Precision characterizes the degree

of mutual agreement among a series of individual measurements, values and/or results. Precision
depends only on the distribution of random errors and does not relate to the true value or specified
value. The measure of precision is usually expressed in terms of imprecision and computed as a
standard deviation of the test results. Accuracy is the degree of conformity of a measured quantity to its
actual (true) value. Accuracy of a measuring instrument is the ability of a measuring instrument to give
responses close to a true value.” (SWGDAM, December 2012)

Accuracy observation

The size differences that are typically observed between sample alleles and the Yfiler™ Plus Allelic
Ladder alleles on the 3500xL Genetic Analyzer with POP-4™ Polymer are shown in Figure 17. The X-axis
represents the nominal base pair sizes for the allelic ladder. The dashed lines parallel to the X-axis
represent the £0.5-bp windows. The Y-axis represents the deviation of each sample allele size from the
corresponding allelic ladder allele size. All sample alleles are within +0.5 bp from a corresponding allele
in the allelic ladder.
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Figure 17 Allele size vs. allelic ladder sizing for 78 samples analyzed on the 3500xL Genetic Analyzer
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Precision and size window description

Sizing precision enables the determination of accurate and reliable genotypes. The recommended
method for genotyping is to use a +0.5-bp “window” around the size obtained for each allele in

the allelic ladder. A +0.5-bp window allows for the detection and correct assignment of alleles. Any
sample allele that sizes outside the specified window could be one of the following:

* An “off-ladder” allele; that is, an allele of a size that is not represented in the allelic ladder
* An allele that does correspond to an allele in the allelic ladder, but whose size is just outside a

window because of measurement error

The measurement error inherent in any sizing method can be defined by the degree of precision in

Marker
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A DYS3891
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DYS570
DYS576
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» YGATAH4

X + 4 A

+

*me
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))
e

sizing an allele multiple times. Precision is measured by calculating the standard deviation in the size
values obtained for an allele that is run in several injections on a capillary electrophoresis instrument.

Precision and size window observation

To view a table of typical precision results, see Table 10.

Extra peaks in the electropherogram

Causes of extra peaks

Peaks other than the target alleles may be detected on the electropherogram. Causes for the
appearance of extra peaks include stutter products, incomplete 3" A nucleotide addition (at the n-1

position), dye artifacts, and mixed DNA samples.

Yfiler™ Plus PCR Amplification Kit User Guide
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Extra peaks: Stutter

Stutter definition

Stutter is a well-characterized PCR artifact that refers to the appearance of a minor peak one repeat
unit smaller than the target STR allele product (minus stutter), or less frequently, one repeat larger

(plus stutter) (Butler, 2005; Mulero et al., 2006). Sequence analysis of stutter products at tetranucleotide
STR loci has revealed that the minus stutter product is missing a single tetranucleotide core repeat unit
relative to the main allele (Walsh et al., 1996). Although plus stutter is normally much less significant
than minus stutter in STR loci with tetranucleotide repeats, the incidence of plus stutter may be more
significant in trinucleotide repeat-containing loci.

Contact HID Support for more information on plus stutter.

The proportion of the stutter product relative to the main allele (percent stutter) is measured by dividing
the height of the stutter peak by the height of the main allele peak.

Stutter observation

Peak heights were measured for amplified samples at the loci that are used in the kit. All data
were generated on the 3500xL Genetic Analyzer. Some conclusions from these measurements and
observations are:

* For each locus, the stutter percentage generally increases with allele length.
* Smaller alleles typically show a lower level of stutter relative to the longer alleles in each locus.
* Each allele in a locus displays a consistent stutter percentage.

* Peaks in the stutter position that are above the stutter filter percentage specified in the software are
not filtered. (Stutter filter percentage is calculated as the mean stutter for the locus plus 3 standard
deviations.) Peaks in the stutter position that have not been filtered and remain labeled can be
further evaluated.

* The measurement of stutter percentage for allele peaks that are off-scale may be unusually high
due to artificial truncation of the main allele peak.

e Stutter can be elevated when minus stutter and plus stutter overlap. This is typically observed
when a given allele flanks another allele that is 2 repeat units away.

* The magnitude and/or variability of stutter may increase with low DNA input amounts.

Marker-specific plus stutter observed in the population study with the Yfiler™ Plus kit is shown in
Figure 18 through Figure 26.

Additional marker-specific plus stutter observed in the population study with the Yfiler™ Plus kit is listed
in “Stutter filter settings provided with the GeneMapper™ ID-X Software” on page 76.
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Extra peaks in the electropherogram =

Percent Stutter
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Figure 18 Minus stutter percentages for the DYF387S1 a/b, DYS19, and DYS385 a/b loci (purple=SID™
dye, green=VIC™ dye, and red=TAZ™ dye).
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Figure 19 Minus stutter percentages for the DYS389 I, DYS389 Il, DYS390, and DYS391 loci (blue=6-
FAM™ dye, black=NED™ dye, and green=VIC™ dye).
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Figure 20 Minus stutter percentages for the DYS392, DYS393, DYS437, and DYS438 loci (black=NED™
dye, purple=SID™ dye, and red=TAZ™ dye).
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dye, green=VIC™ dye, red=TAZ™ dye, and black=NED™ dye).
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Minus stutter percentages for the DYS439, DYS448, DYS449, and DYS456 loci (purple=SID™
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Figure 22 Minus stutter percentages for the DYS458, DYS460, DYS481, and DYS518 loci (green=VIC™

dye, purple=SID™ dye, and black=NED™ dye).
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Figure 23 Minus stutter percentages for the DYS533, DYS570, and DYS576 loci (purple=SID™ dye,
red=TAZ™ dye, and blue=6-FAM™ dye).
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Figure 24 Minus stutter percentages for the DYS627, DYS635, and YGATAH4 loci (blue=6-FAM™ dye and
green=VIC™ dye).
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Figure 25 Example of reproducible 2-bp stutters in the DYS19 loci.
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Figure 26 Example of reproducible 2-bp stutters in the DYS481 loci.
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Stutter filter settings provided with the GeneMapper™ ID-X Software

The stutter filter settings are shown in Table 4 and Table 5. The data used to derive the settings are
shown in Figure 18 through Figure 24. The proportion of the stutter product relative to the main allele
(stutter percent) is measured by dividing the height of the stutter peak by the height of the main allele
peak.

IMPORTANT! The values that are shown in the tables are the values that were determined during
developmental validation studies using specific data sets. To determine the appropriate values to use
for your applications, always perform internal validation studies.

Table 4 Percentages used in the minus stutter filters included with the GeneMapper™ ID-X Software

% Minus stutter % Mean % Minimum % Maximum 2 bp % (mean
Locus (mean + 3 standard stutter stutter stutter + 3 standard
deviations) deviations)
DYS576 15.15 10.44 5.95 20.27 Undetermined
DYS389I 9.16 6.08 3.47 10.88 Undetermined
DYS635 13.38 7.54 2.82 21.59 Undetermined
DYS389lI 18.79 13.88 9.15 20.88 Undetermined
DYS627 15.18 9.90 5.14 28.17 2.71
DYS460 11.65 7.32 0.58 13.92 Undetermined
DYS458 15.31 10.58 3.58 16.74 Undetermined
DYS19 12.68 8.27 0.86 15.12 10.10
YGATAH4 11.53 7.75 4.07 22.14 Undetermined
DYS448 4.68 2.62 0.66 13.11 Undetermined
DYS391 9.99 6.58 3.23 13.25 Undetermined
DYS456 15.36 11.34 7.10 17.62 Undetermined
DYS390 13.58 8.74 4.72 16.21 Undetermined
DYS438 5.86 3.59 1.50 7.62 Undetermined
DYS392 16.94 10.27 3.27 31.35 Undetermined
DYS518 25.50 18.07 11.70 46.29 Undetermined
DYS570 15.65 10.88 412 21.49 Undetermined
DYS437 8.13 4.83 1.60 13.26 Undetermined
DYS385 a/b 18.32 10.02 3.26 21.54 Undetermined
DYS449 23.24 16.80 11.40 25.61 Undetermined
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Table 4 Percentages used in the minus stutter filters included with the GeneMapper ID-X Software

(continued)
0, i [v)
LI % Mean % Minimum % Maximum LT o
Locus (mean + 3 standard + 3 standard
- stutter stutter stutter "
deviations) deviations)
DYS393 14.07 9.97 6.63 19.17 Undetermined
DYS439 9.89 6.74 3.55 11.98 Undetermined
DYS481 28.55 19.98 12.02 28.95 9.55
DYF387S1 a/b 15.71 9.96 4.41 30.78 Undetermined
DYS533 12.00 7.94 2.37 18.11 1.88

Table 5 Perce

ntages used in the plus stutter filters included with the GeneMapper™ ID-X Software

% Plus stutter
.. . 2 bp % (mean
(mean + % Minimum % Maximum
Locus % Mean stutter + 3 standard
3 standard stutter stutter L.
.. deviations)
deviations)
DYS576 3.38 1.15 0.42 8.45 Undetermined
DYS389I 3.45 0.81 0.23 8.94 Undetermined
DYS635 3.30 1.06 0.26 6.94 Undetermined
DYS389ll 3.73 1.01 0.33 9.35 Undetermined
DYS627 2.62 0.95 0.26 6.40 Undetermined
DYS460 4.27 1.17 0.34 24.71 Undetermined
DYS458 2.52 0.95 0.34 5.86 Undetermined
DYS19 3.72 1.26 0.43 14.81 3.42
YGATAH4 2.27 0.94 0.33 4.55 Undetermined
DYS448 2.29 0.76 0.25 3.40 Undetermined
DYS391 3.41 0.98 0.33 9.02 Undetermined
DYS456 3.74 2.03 0.73 7.09 Undetermined
DYS390 3.51 1.19 0.35 3.36 Undetermined
DYS438 2.76 0.97 0.35 2.87 Undetermined
DYS392 11.00 6.32 1.91 16.65 Undetermined
DYS518 4.85 1.78 0.69 13.46 Undetermined
DYS570 2.88 1.15 0.45 10.50 Undetermined
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Table 5 Percentages used in the plus stutter filters included with the GeneMapper ID-X Software

(continued)
0,
% Plus stutter . . Pl 9 (i
(mean + % Minimum % Maximum
Locus % Mean stutter + 3 standard
3 standard stutter stutter "
.. deviations)
deviations)
DYS437 1.65 0.70 0.23 2.28 Undetermined
DYS385 a/b 3.70 1.12 0.19 13.17 Undetermined
DYS449 4.20 1.50 0.57 12.83 Undetermined
DYS393 4,95 2.07 0.59 22.21 Undetermined
DYS439 3.39 1.24 0.43 14.17 Undetermined
DYS481 5.59 2.59 0.96 21.03 Undetermined
DYF387S1 a/b Undetermined Undetermined Undetermined Undetermined Undetermined
DYS533 4.60 1.71 0.70 5.73 Undetermined

Extra peaks: Addition of 3' A nucleotide

3’ A nucleotide addition definition

78

Many DNA polymerases can catalyze the addition of a single nucleotide (predominantly adenosine) to
the 3’ ends of double-stranded PCR products (Clark, 1988; Magnuson et al., 1996). This nontemplate
addition results in a PCR product that is one nucleotide longer than the actual target sequence. The
PCR product with the extra nucleotide is referred to as the “+A” form.

3’ A observation

The efficiency of +A addition is related to the particular sequence of the DNA at the 3" end of the PCR
product. The kit includes two main design features that promote maximum +A addition:

* The primer sequences have been optimized to encourage +A addition.

* The PCR chemistry allows complete +A addition with a short final incubation for 22 minutes at
60°C.

This final extension step gives the DNA polymerase additional time to complete +A addition to

all double-stranded PCR products. Examples of incomplete and normal +A addition are shown in
Figure 27. Final extension incubation for longer than the recommended time can result in double +A
addition, in which two nontemplate adenosine residues are added to the PCR product. Double +A
addition can cause "shoulders" on the right side of main allele peaks, and is therefore to be avoided.

Due to improved PCR buffer chemistry, the lack of +A addition is generally less of an issue with the
Yfiler™ Plus kit than with earlier generation kits. However, "shouldering" of allele peaks can still be
observed if the amount of input DNA is greater than recommended concentration. Amplification of
excess input DNA can also result in off-scale data.
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Figure 27 Omitting the final extension step results in shoulders on main allele peaks due to incomplete A
nucleotide addition. Examples shown are the smaller amplicons of FAM™, NED™, and SID™ dye channel data from
a 3500xL Genetic Analyzer using the Yfiler™ Plus kit.

Extra peaks: Artifacts
Artifact definition

Artifacts and anomalies are seen in all molecular biological systems. Artifacts are typically reproducible.
Anomalies are non-reproducible, intermittent occurrences that are not observed consistently in a
system (for example, spikes and baseline noise).
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Additional reproducible DNA-dependent artifacts have been characterized and recorded in Table 6. It is
important to consider possible noise and artifacts when interpreting data from the Yfiler™ Plus kit on the
3500/3500xL Genetic Analyzer and 3130/3130x/ Genetic Analyzer.

Table 6 DNA-dependent artifacts

Artifact Color Size Comment

FAM270 Blue |270-271 bp | Minor cross-reactive product observed with female DNA >1 pug.

FAM280 Blue |280-281 bp | Minor cross-reactive product observed with female DNA >1 pug.

FAM348 Blue |348-349 bp | Specific to the cell-line derived DNA Control 007 in the kit.

DYS391 (n-10) |Green| n-10bp | Specific to DYS391. Minor cross-reactive product observed with male DNA >
1.0 ng.

TAZ140 Red | 139-140 bp | Minor cross-reactive product observed with female DNA >1 pug.

TAZ144 Red | 144-145 bp | Minor cross-reactive product observed with female DNA >1 pg.

TAZ225-260 Red |225-260 bp | Multiple minor cross-reactive products observed with female DNA >1 pg.

TAZ412 Red |412-413 bp | Cross-reactive product observed with female DNA >100 ng. Occurs outside of
the read region. Does not impact interpretation.

VIC70 Green 70 bp Sporadic PCR artifact. Occurs outside of the VIC™ dye read region. Does not
impact interpretation.

DYS437 (n-5) | Red n-5bp |Specific to DYS437. Sporadic, non-target specific artifact.

DYS437 (n-12)| Red | n-12 bp | Specific to DYS437. Sporadic, non-target specific artifact.

DYS437 (n-16)| Red | n—-12 bp | Specific to DYS437. Sporadic, non-target specific artifact.

80
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Figure 28 Example of the TAZ412 reproducible artifact in data produced on the 3500/3500xL Genetic
Analyzer.
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Figure 29 Example of the FAM348 reproducible artifact in data produced on the 3500/3500xL Genetic
Analyzer.
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Figure 30 Example of the DYS391 (n-10) reproducible artifact in data produced on the
3500/3500xL Genetic Analyzer.
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Figure 31 Examples of the DYS437 artifacts in data produced on the 3500/3500xL Genetic Analyzer

Characterization of loci

SWGDAM guideline 3.1

“The basic characteristics of a genetic marker should be determined and documented.” (SWGDAM,
December 2012)

Loci in this kit

This section describes basic characteristics of the 27 Y-STR loci that are amplified with the Yfiler™ Plus
kit. Most of these loci have been extensively characterized by other laboratories.

Nature of polymorphisms

DYS392 and DYS481 are trinucleotide repeats, DYS438 is a pentanucleotide repeat and DYS448 is

a hexanucleotide repeat. Their allele differences result from differences in the number of repeat units
3-bp, 5-bp, and 6-bp respectively. The remaining Yfiler™ Plus kit loci are tetranucleotide short tandem
repeat (STR) loci. The length differences among alleles of these particular loci result from differences in
the number of 4-bp repeat units.

We have sequenced all the alleles in the Yfiler™ Plus kit Allelic Ladder. In addition, other groups
in the scientific community have sequenced alleles at some of these loci (Redd et al., 2002;
www.cstl.nist.gov/biotech/strbase/y_strs.htm). Among the various sources of sequence data on the
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loci, there is consensus on the repeat patterns and structure of the STRs (Mulero et al., 2014; Gusmao
et al., 2006).

Inheritance

The Centre d'Etude du Polymorphisme Humain (CEPH) has collected DNA from families of Utah
Mormon, French Venezuelan, and Amish descent. These DNA sets have been extensively studied all
over the world and are routinely used to characterize the mode of inheritance of various DNA loci.
Each family set contains three generations, generally including four grandparents, two parents, and
several offspring. Consequently, the CEPH family DNA sets are ideal for studying inheritance patterns
(Begovich et al., 1992).

Mapping

The Yfiler™ Plus kit loci have been mapped, and the location on the Y-chromosome is known based on
the nucleotide sequence of the Y-chromosome. The Genbank accession numbers for representative
sequences are: DYS19 (X77751, AC017019), DYS385 (AC022486, Z93950), DYS389 (AC011289,
AF140635), DYS390 (AC011289), DYS391 (G09613, AC011302), DYS392 (G09867, AC06152), DYS393
(G09601, AC06152), DYS437 (AC002992), DYS438 (AC002531), DYS439 (AC002992), DYS448
(AC025227.6), DYS456 (AC010106.2), DYS458 (AC010902.4), DYS635 (G42676, AC011751), DYS635
(G42673), DYS449 (AC051663), DYS481 (FJ828747.1), DYS533 (AC053516), DYS570 (AC012068),
DYS576 (AC010104), DYS518 (FJ828760) and DYS627 (BV208976).

Species specificity

SWGDAM Guideline 3.2

“The ability to detect genetic information from non-targeted species (e.g., detection of microbial DNA in
a human assay) should be determined. The detection of genetic information from non-targeted species
does not necessarily invalidate the use of the assay, but may help define the limits of the assay.”
(SWGDAM, December 2012)

Nonhuman study observation

The Yfiler™ Plus kit provides the required specificity for detecting human alleles. Species specificity
testing was performed to show that there is no cross-reactivity with nonhuman DNA that may be
present in forensic casework samples.

The following species were tested (in the specified amounts) using standard PCR and capillary
electrophoresis conditions for the kit:

* Primates—Gorilla, chimpanzee, and macaque (1.0 ng each)

* Non-primates—Mouse, dog, pig, rat, sheep, horse, chicken, and cow (10.0 ng each)

* Microorganisms—Candida albicans, Neisseria gonorrhoeae, Escherichia coli 0157:H7, Bacillus
subtilis, Staphylococcus aureus, and Lactobacillus rhamnosus (5 ng each)

Results were evaluated for the presence of any amplified peaks that would indicate cross-reactivity of
the kit with any of these non-human species.
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The chimpanzee and gorilla DNA samples produced partial profiles in the 100-330 bp region. The

remaining species tested did not yield reproducible detectable products.

Example electropherogram results from the species specificity tests are shown in Figure 32.
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Figure 32 Representative electropherograms from a species specificity study including positive and

negative control (Y-axis scale 0-200 or 0-3,200 RFU).

Sensitivity

SWGDAM guideline 3.3

“The ability to obtain reliable results from a range of DNA quantities, to include the upper and lower

limits of the assay, should be evaluated.” (SWGDAM, December 2012)

Effect of DNA quantity on results

If too much DNA is added to the PCR reaction, the increased amount of PCR product that is generated

can result in the following:

Fluorescence intensity that exceeds the linear dynamic range for detection by the capillary

electrophoresis instrument (“off-scale” data). Off-scale data are a problem because:

- Quantification (peak height and area) for off-scale peaks is not accurate. For example, an allele
peak that is off-scale can cause a corresponding stutter peak to appear higher in relative

intensity, therefore increasing the calculated percent stutter.

spectral separation (“pull-up”).
Incomplete +A nucleotide addition.
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Multicomponent analysis of off-scale data is not accurate. This inaccuracy results in poor
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To address these problems, rerun the amplification reaction using less DNA.

If too little DNA is added to the PCR reaction, the total number of allele copies added to the
PCR reaction could be extremely low. Unbalanced amplification of the alleles can occur because of
stochastic fluctuation.

Sample collection factors that can affect DNA quantity

The Yfiler™ Plus kit has been optimized for a PCR reaction volume of 25 L to overcome the PCR
inhibition expected when amplifying:

* Blood samples that are obtained directly from unpurified 1.2-mm treated paper discs

* Buccal cells that are obtained directly from unpurified 1.2-mm treated paper discs (with the
addition of Prep-n-Go™ Buffer)

* Buccal swab sample lysate that is prepared using Prep-n-Go™ Buffer

Depending on the following conditions, DNA quantities present on the 1.2-mm disc may vary from
laboratory to laboratory:

* Volume of blood that is spotted onto the treated paper

Collecting devices that are used
* Collection methods that are applied

* Swab-to-paper transfer protocol that is used

It is essential to optimize the PCR conditions for the blood sample type and spotting protocol. See
“(Before first use of the kit) Optimize PCR cycle number” on page 24.

Sensitivity observation

The amplification results of different input DNA amounts are shown in Figure 33. The optimal amount of
input male DNA added to the Yfiler™ Plus kit is 0.5-1.0 ng for 30-cycle PCR when using extracted and
purified DNA. The final DNA concentration should be 0.05-0.10 ng/pL, so that 0.5-1.0 ng of male DNA
is added to the 10-uL PCR reaction.

If the sample contains degraded DNA, amplification of additional DNA can be beneficial.

To determine an appropriate minimum peak height threshold for your instruments and data, perform
internal validation studies.
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Figure 33 Effect of amplifying 1 ng, 500 pg, 250 pg, 125 pg, 62 pg, and 31 pg of male DNA Control
007 using two voltage conditions. Data analyzed using the 3500xL Genetic Analyzer (Y-axis scale 0-
12,000 RFU).

Stability

SWGDAM guideline 3.4

“The ability to obtain results from DNA recovered from biological samples deposited on various
substrates and subjected to various environmental and chemical insults should be evaluated. In

most instances, assessment of the effects of these factors on new forensic DNA procedures is not
required. However, if substrates and/or environmental and/or chemical insults could potentially affect
the analytical process, then the process should be evaluated to determine the effects of such factors.”
(SWGDAM, December 2012)

Lack of amplification of some loci
As with any multi-locus system, the possibility exists that not every locus amplifies. This possibility is

most often observed when the DNA sample contains PCR inhibitors or when the DNA sample has been
severely degraded. Valuable information can be obtained from partial profiles.
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Degraded DNA

As the average size of degraded DNA approaches the size of the target sequence, the amount of PCR
product generated is reduced. This is due to the reduced number of intact templates in the size range
necessary for amplification.

Degraded DNA was prepared to examine the potential for preferential amplification of loci. High
molecular weight DNA was incubated with the enzyme DNase | for varying amounts of time. The DNA
was examined by agarose gel analysis to determine the average size of the DNA fragments at each time
point.

2 ng of degraded DNA (or 1 ng undegraded DNA) was amplified using the Yfiler™ Plus kit. As the
DNA became increasingly degraded, the loci became undetectable according to size. The loci failed to
robustly amplify in the order of decreasing size as the extent of degradation progressed (Figure 34).
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Figure 34 Amplification of A3121 DNA samples sonicated and incubated with increasing doses of
DNase I. Panels 1, 2, 3, and 4 correspond to 0, 4, 5, and 6 Units of DNase |. Note that the Y-axis scale is
magnified for more degraded samples, which generate lower peak heights.
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Effect of inhibitors—humic acid

Traces of humic acid can inhibit the PCR amplification of DNA evidence collected from soil.
Amplification of 1.0 ng of DNA Control 007 in the presence of increasing amounts of humic acid was
performed using the Yfiler™ Plus kit (Figure 35). The concentrations of humic acid tested were 0, 100,
and 250 ng/pL. The same concentrations were tested with the Yfiler™ kit for comparison. At 250 ng/uL,

neither kit yielded amplified products.

Mark Sample for Deleton

= =

808 8 8 B 8§ 8 &

Yfiler Plus kit uninhibited control

Mark Sample for Deleton
= =

8 ¢ 8 ¢ 8§ 8 § 8

Yfiler Plus kit with 100 ng/uL humic acid

..A.l IL.

Mark Sample for Deleton
= =

R TV S B Y

Yfiler kit uninhibited control

. - o - A

Mark Sample for Deleton

= =

¢ 8 8 § 8 B ¥ § %

L £ P e .

e

i

Yfiler kit with 100 ng/pL humic acid

Figure 35 Electropherograms for the Yfiler™ Plus kit and Yfiler™ kit show the improved performance of
the Yfiler™ Plus kit in the presence of humic acid compared to the Yfiler™ kit [Y-axis scale 0-20,000 RFU
(top two panels), 0-30,000 RFU (third panel), and 0-4,000 RFU (bottom panel)].
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Mixture studies

SWGDAM guideline 3.8

“The ability to obtain reliable results from mixed source samples should be determined.” (SWGDAM,
December 2012)

Mixture study overview

Evidence samples may contain DNA from more than one individual. The possibility of multiple
contributors should be considered when interpreting the results. Perform studies to determine a
minimum peak height threshold to avoid typing when stochastic effects are likely to interfere with
accurate interpretation of mixtures.

Evidence samples that contain body fluids and/or tissues originating from more than one individual are
an important category of forensic casework.

It is essential that the DNA typing system is able to detect DNA mixtures. Typically, mixed samples can
be distinguished from single-source samples by:
* The presence of more than one allele at Y-STR loci
* The presence of a peak at a stutter position that is significantly greater in percentage than typically
observed in a single-source sample

If an unusually low interlocus balance is observed for one locus, and there are no other indications
that the sample is a mixture, re-amplify and reanalyze the sample to determine if the imbalance is
reproducible. Possible causes of imbalance at a locus are:

* Degraded DNA

* Presence of inhibitors

¢ Extremely low amounts of input DNA

* A mutation in one of the primer binding sites

* Presence of an allele containing a rare sequence that does not amplify as efficiently as the other
allele

Male/female mixture studies

In the case of Y-STRs, the female DNA component is not amplified by the Y-chromosome-specific
primers. Male/female mixture studies were performed up to a ratio of 1:4,000 using 3 different female
DNA samples. The amount of female DNA was kept constant at 1 ug and the amount of male control
DNA was changed. The female DNA did not cause any interference with the interpretation of the male
Y-STR profile as shown in Figure 36.

Low-level artifacts with female DNA have been occasionally observed in the FAM™ (270-280 bp) and
TAZ™ (225-260 bp) dyes. In general, these artifact peaks will not affect interpretation due to their
morphology and intensity.
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Figure 36 Amplification of male DNA Control 007 in the presence of female Control DNA 9947A. Profiles
shown in the panels from top to bottom: 1 ng of male DNA, 1 ng of male DNA with 1 pg of female DNA,
500 pg of male DNA with 1 pg of female DNA, 250 pg of male DNA with 1 pg of female DNA, 1 pg of
female DNA. The Y-axis scale is magnified for lower input amounts of male DNA samples, which generate lower peak
heights. The Y-axis scale is 0-200 RFU for the 1-pg female input.

Male/male mixture studies

Forensic samples may contain body fluids or tissues that originate from more than one male. Mixtures
of two male DNA samples were examined at various ratios (1:1 to 1:15). The total amount of genomic
input DNA mixed at each ratio was 1 ng.

Table 7 Haplotypes of two male DNA samples

Locus Sample A Sample B
DYS576 15 19
DYS389I 14 13
DYS635 21 24
DYS389ll 31 29
DYS627 21 21
DYS460 10 11
DYS458 17 17

DYS19 15 15

YGATAH4 12 13
DYS448 21 19
DYS391 10 11
DYS456 13 15
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Table 7 Haplotypes of two male DNA samples (continued)

Locus Sample A Sample B
DYS390 21 24
DYS438 12 12
DYS392 11 13
DYS518 38 37
DYS570 19 17
DYS437 14 15

DYS385 a/b 16, 19 11,14
DYS449 29 30
DYS393 14 13
DYS439 11 12
DYS481 27 22

DYF387S1 a/b 36, 39 35, 37
DYS533 11 13

A representative electropherogram of 1-ng total male/male DNA mixture studies is shown in Figure 37.
The limit of detection is when the minor component is present at approximately one-tenth of the
concentration of the major component. The limit of detection for the minor component is influenced by

the combination of genotypes in the mixture.
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Figure 37 Mixtures of two male DNA samples (1:8 ratio, 125 pg: 875 pg) 1-ng input DNA. The alleles
attributable to the minor component, even when the major component shares an allele, are highlighted.
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Population data

SWGDAM YSTR guideline 10.1

"The laboratory should establish guidelines for the number of Y-STR loci used for searches of

population databases." (SWGDAM, January 2014)

Population data overview

All Y-STR loci analyzed in commercial kits are physically linked on the Y-chromosome. Due to the lack
of recombination, the entire Y-chromosome haplotype must be treated as a single locus. Haplotype
frequencies are estimated using the counting method. The counting method involves searching a given
haplotype against a database to determine the number of times the haplotype was observed in that
database. The frequency of the haplotype in the database is then estimated by dividing the count by
the number of haplotypes searched. (SWGDAM, January 2014)

Population samples used in these studies

The Yfiler™ Plus kit was used to generate the population data provided in this section. Whole blood
samples were provided by the Interstate Blood Bank (Memphis, Tennessee) and Boca Biolistics
(Coconut Creek, Florida). Samples were collected in the United States (with no geographical preference)
from randomly selected individuals of known ethnicities. Ethnicities of sample donors were:

* African-American—557 samples
* U.S. Asian—340 samples

* U.S. Caucasian—533 samples

* U.S. Hispanic—391 samples

DNA was extracted with a 6100 Nucleic Acid Prep Station.
The Yfiler™ Plus kit contains loci for which extensive population data are available.

In addition to the haplotypes that we observed and recorded in our databases, other alleles have been
published or reported to us by other laboratories (see the STRBase at htitps://strbase.nist.gov/, see
the YHARD at www.yhrd.org, and see the U.S. Y-STR database at www.usystrdatabase.org).
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Gene diversity values

The Yfiler™ Plus gene diversity in four populations are listed in Table 8.

n(l -Zp?)
n—1

Gene diversity (D) =

where: n=sample size, pi=allele frequency (Johnson et al., 2003)

Table 8 Yfiler™ Plus gene diversity values across 4 different U.S. populations, listed as

percentages
Locus Africa(lrr:;ggirican U.S.(:::g;n)sian US(n I;I:i;sgg?le)mic U.S. Asian (n=340)
DYS576 0.807 0.768 0.769 0.799
DYS389 | 0.504 0.527 0.567 0.679
DYS635 0.716 0.646 0.713 0.786
DYS389 I 0.746 0.676 0.729 0.770
DYS627 0.838 0.842 0.853 0.812
DYS460 0.573 0.537 0.571 0.675
DYS458 0.750 0.766 0.800 0.820
DYS19 0.726 0.459 0.632 0.703
YGATAH4 0.590 0.585 0.580 0.606
DYS448 0.707 0.583 0.697 0.755
DYS391 0.445 0.540 0.561 0.437
DYS456 0.615 0.737 0.700 0.603
DYS390 0.646 0.684 0.656 0.699
DYS438 0.551 0.581 0.688 0.547
DYS392 0.445 0.592 0.664 0.710
DYS518 0.843 0.806 0.807 0.867
DYS570 0.806 0.738 0.799 0.820
DYS437 0.504 0.577 0.592 0.476
DYS385 a/b 0.942 0.854 0.904 0.973
DYS449 0.857 0.783 0.818 0.882
DYS393 0.587 0.363 0.442 0.662
DYS439 0.629 0.625 0.682 0.669
DYS481 0.857 0.724 0.790 0.821
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Table 8 Yfiler Plus gene diversity values across 4 different U.S. populations, listed as
percentages (continued)

African-American U.S. Caucasian U.S. Hispanic .
Locus (n=557) (n=533) (n=391) U.S. Asian (n=340)
DYF387S1 a/b 0.941 0.874 0.913 0.945
DYS533 0.598 0.576 0.591 0.644

Analyzing the population data

In addition to the alleles that were observed and recorded in the Thermo Fisher Scientific databases,
other known alleles have been published or reported to us by other laboratories. Some of these alleles
occur at a low frequency and include several microvariants (Furedi et al., 1999; Schoske et al., 2004).

Discriminatory capacity of haplotypes

The discriminatory capacity was determined by dividing the number of different haplotypes by the
number of samples in that population (Schoske et al., 2004). A unique haplotype is defined as one
that occurs only once in a given population. The number of unique haplotypes is usually less than the
number of different haplotypes in any given population.

The discriminatory capacity (DC) and the number of unique haplotypes (UH) for each Y-STR marker

combination are li

sted in Table 9.

Table 9 Discriminatory capacity and number of unique haplotypes for 4 U.S. populations

African-American U.S. Caucasian U.S. Hispanic U.S. Asian
Y-STR marker (n = 557) (n = 533) (n = 391) (n = 340)
combination
DC (%) UH DC (%) UH DC (%) UH DC (%) UH
Yfiler™ 98.2 547 95.7 510 95.9 375 91.5 311
Yfiler™ Plus 99.6 555 98.5 525 98.0 383 94.4 321

Mutation rate

The most accurate method of estimating Y-STR mutation rates is the direct observation of transmission
between father and son. A large-scale Y-STR analysis of mutation rates was performed with 2,000
DNA-confirmed father-son pairs and encompassed the Yfiler™ Plus marker set (Ballantyne et al., 2010,
2012, and 2014).
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Table of Precision Results

Table of typical precision results

Table 10 Example of precision results of seven injections of a Yfiler™ Plus Allelic Ladder run on a 3130x/
Genetic Analyzer, 3500 Genetic Analyzer, and 3500xL Genetic Analyzer

3130x/ 3500 3500xL
Allele
Standard deviation Mean Standard deviation Mean Standard deviation Mean
DYF387S1 a/b
30 264.16-264.33 0.038-0.055 264.90-264.93 0.045-0.063 264.85-264.89 0.038-0.057
31 268.02-268.20 0.035-0.054 268.81-268.83 0.052-0.064 268.74-268.78 0.045-0.059
32 271.91-272.10 0.031-0.056 272.69-272.72 0.042-0.053 272.63-272.68 0.040-0.058
33 275.87-276.03 0.035-0.054 276.65-276.69 | 0.045-0.068 | 276.58-276.63 0.046-0.054
34 279.72-279.90 0.038-0.055 280.54-280.58 0.049-0.072 280.47-280.51 0.049-0.062
35 283.52-283.71 0.044-0.062 284.33-284.37 0.037-0.063 284.26-284.30 0.049-0.057
36 287.35-287.55 0.043-0.054 288.17-288.22 0.049-0.066 | 288.12-288.16 0.042-0.057
37 291.25-291.44 0.034-0.055 292.10-292.11 0.044-0.075 292.01-292.06 0.042-0.062
38 295.03-295.22 0.043-0.065 295.89-295.91 0.047-0.067 295.79-295.85 0.037-0.062
39 299.06-299.26 0.045-0.055 299.93-299.96 0.064-0.068 299.85-299.90 0.046-0.063
40 302.75-302.95 0.039-0.054 303.61-303.65 | 0.048-0.073 | 303.52-303.60 0.047-0.065
41 306.64-306.86 0.035-0.066 | 307.56-307.60 | 0.038-0.087 | 307.48-307.53 0.050-0.062
42 310.49-310.70 0.047-0.060 311.44-311.47 0.062-0.080 311.35-311.41 0.046-0.066
43 314.40-314.62 0.041-0.073 315.40-315.43 0.046-0.096 315.30-315.37 0.045-0.070
44 318.47-318.69 0.039-0.062 319.50-319.52 0.048-0.089 | 319.40-319.47 0.047-0.071
DYS19
9 183.90-183.94 0.023-0.030 184.04-184.06 0.028-0.048 183.99-184.01 0.026-0.039
10 188.07-188.11 0.022-0.036 188.20-188.22 0.026-0.035 188.16-188.18 0.026-0.040
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Appendix A Table of Precision Results
Table of typical precision results

Table 10 Example of precision results of seven injections of a Yfiler Plus Allelic Ladder run on a 3130xI
Genetic Analyzer, 3500 Genetic Analyzer, and 3500xL Genetic Analyzer (continued)

3130x/ 3500 3500xL
Allele

Standard deviation Mean Standard deviation Mean Standard deviation Mean

11 192.11-192.13 0.026-0.036 192.26-192.28 0.026-0.040 192.22-192.24 0.025-0.037

12 196.10-196.13 0.018-0.039 196.24-196.27 0.032-0.046 196.21-196.23 0.032-0.041

13 200.17-200.21 0.019-0.034 200.30-200.33 0.029-0.046 200.28-200.29 0.037-0.043

14 204.09-204.13 0.020-0.036 204.24-204.27 0.027-0.038 204.21-204.21 0.029-0.037

15 208.05-208.09 0.018-0.028 208.22-208.24 0.029-0.043 208.16-208.18 0.027-0.038

16 212.03-212.05 0.023-0.032 212.20-212.26 0.015-0.053 212.15-212.16 0.024-0.046

17 216.07-216.10 0.023-0.032 216.22-216.25 0.016-0.052 216.18-216.20 0.029-0.044

18 220.14-220.19 0.020-0.034 220.30-220.34 0.033-0.046 220.27-220.29 0.020-0.043

19 224.15-224.20 0.024-0.035 224.34-224.35 0.040-0.058 224.30-224.31 0.036-0.047

DYS385 a/b
6 225.25-225.31 0.029-0.041 225.10-225.12 0.022-0.050 225.07-225.09 0.036-0.048
7 229.25-229.33 0.027-0.041 229.12-229.14 0.028-0.044 229.08-229.11 0.042-0.047
8 233.37-233.44 0.026-0.042 233.21-233.24 0.026-0.045 233.19-233.21 0.038-0.048
9 237.40-237.47 0.028-0.037 237.24-237.26 0.023-0.066 237.22-237.25 0.033-0.046

10 241.50-241.57 0.026-0.049 241.31-241.34 0.035-0.052 241.30-241.31 0.023-0.038

11 245.53-245.61 0.024-0.040 245.37-245.38 0.022-0.046 245.34-245.37 0.031-0.046

12 249.71-249.81 0.027-0.038 249.53-249.55 0.005-0.034 249.51-249.54 0.034-0.043

13 253.74-253.84 0.025-0.037 253.55-253.57 0.021-0.040 253.55-253.57 0.030-0.046

14 257.69-257.79 0.027-0.047 257.50-257.52 0.031-0.047 257.51-257.52 0.028-0.041

15 261.66-261.75 0.023-0.039 261.46-261.49 0.031-0.040 261.48-261.50 0.033-0.043

16 265.67-265.76 0.027-0.041 265.50-265.51 0.018-0.044 265.50-265.52 0.030-0.046

17 269.72-269.82 0.022-0.047 269.54-269.58 0.022-0.042 269.55-269.57 0.036-0.046

18 273.73-273.83 0.026-0.045 273.54-273.58 0.027-0.055 273.54-273.57 0.029-0.047

19 277.83-277.93 0.025-0.046 277.64-277.66 0.040-0.058 277.65-277.67 0.031-0.042

20 281.85-281.95 0.025-0.044 281.66-281.70 0.035-0.044 281.67-281.69 0.033-0.044

21 285.85-285.94 0.029-0.044 285.65-285.69 0.036-0.043 285.67-285.68 0.030-0.043

22 289.82-289.93 0.029-0.052 289.63-289.65 0.037-0.050 289.63-289.66 0.030-0.040
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Appendix A Table of Precision Results
Table of typical precision results

Table 10 Example of precision results of seven injections of a Yfiler Plus Allelic Ladder run on a 3130xI
Genetic Analyzer, 3500 Genetic Analyzer, and 3500xL Genetic Analyzer (continued)

3130x/ 3500 3500xL
Allele
Standard deviation Mean Standard deviation Mean Standard deviation Mean
23 293.78-293.89 | 0.031-0.046 | 293.58-293.62 | 0.030-0.040 | 293.58-293.60 | 0.032-0.047
24 297.79-297.89 | 0.029-0.042 | 297.57-297.60 | 0.037-0.065 | 297.56-297.60 | 0.034-0.050
25 301.75-301.85 0.025-0.052 301.56-301.58 0.038-0.045 301.55-301.57 0.020-0.050
26 305.71-305.82 0.034-0.039 305.51-305.53 0.018-0.054 305.51-305.53 0.026-0.039
27 309.71-309.82 0.036-0.044 | 309.50-309.55 | 0.028-0.042 | 309.52-309.54 | 0.032-0.044
28 313.78-313.87 | 0.032-0.051 313.53-313.58 | 0.005-0.051 313.55-313.58 | 0.043-0.049
DYS389I
9 146.74-146.78 0.025-0.034 146.98-147.01 0.019-0.044 146.81-146.84 0.025-0.042
10 150.83-150.87 | 0.026-0.033 151.06-151.09 | 0.019-0.039 150.90-150.91 0.032-0.041
11 154.86-154.91 0.024-0.031 155.09-155.11 0.030-0.042 154.92-154.94 0.034-0.038
12 158.98-159.04 0.027-0.036 159.22-159.24 0.007-0.030 159.04-159.07 0.021-0.035
13 163.19-163.26 0.020-0.031 163.41-163.43 0.028-0.045 163.25-163.27 0.026-0.038
14 167.12-167.19 0.018-0.034 167.33-167.35 0.015-0.030 167.18-167.19 0.027-0.033
15 171.17-171.21 0.017-0.040 171.34-171.37 0.022-0.039 171.21-171.22 0.021-0.038
16 175.19-175.24 0.020-0.025 175.37-175.40 0.020-0.046 175.23-175.24 0.026-0.039
17 179.23-179.28 0.013-0.034 179.40-179.41 0.005-0.032 179.25-179.27 0.041-0.045
DYS389lI
24 265.02-265.11 0.025-0.032 265.16-265.20 0.023-0.060 265.12-265.12 0.030-0.044
25 269.11-269.20 0.024-0.040 269.23-269.25 0.030-0.052 269.17-269.18 0.030-0.042
26 273.08-273.17 0.021-0.043 273.23-273.24 0.026-0.040 273.15-273.17 0.028-0.042
27 277.22-277.32 0.024-0.039 277.36-277.39 0.036-0.054 277.29-277.31 0.030-0.042
28 281.15-281.25 0.020-0.048 281.29-281.32 0.032-0.047 281.21-281.22 0.034-0.043
29 285.01-285.10 0.019-0.041 285.14-285.16 0.029-0.043 285.07-285.09 0.028-0.041
30 289.17-289.26 0.026-0.047 289.31-289.33 0.027-0.039 289.23-289.25 0.034-0.039
31 293.15-293.24 0.023-0.043 293.27-293.31 0.037-0.040 293.19-293.21 0.023-0.037
32 297.02-297.11 0.027-0.035 297.14-297.15 0.029-0.059 297.04-297.07 0.028-0.044
33 300.97-301.06 0.025-0.041 301.10-301.13 0.039-0.049 301.02-301.03 0.037-0.043
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Table of typical precision results

Table 10 Example of precision results of seven injections of a Yfiler Plus Allelic Ladder run on a 3130xI
Genetic Analyzer, 3500 Genetic Analyzer, and 3500xL Genetic Analyzer (continued)

3130x/ 3500 3500xL
Allele

Standard deviation Mean Standard deviation Mean Standard deviation Mean

34 304.81-304.89 0.024-0.035 304.93-304.96 0.025-0.060 304.85-304.86 0.031-0.038

35 308.89-308.97 0.027-0.041 309.01-309.03 0.036-0.046 308.93-308.94 0.040-0.050

DYS390

17 144.14-144.23 0.026-0.044 144.14-144.19 0.038-0.042 144.09-144.11 0.029-0.039

18 148.04-148.12 0.020-0.038 148.06-148.10 0.021-0.051 147.98-148.01 0.035-0.043

19 151.96-152.04 0.026-0.037 151.99-152.02 0.026-0.043 151.92-151.93 0.029-0.039

20 156.15-156.25 0.027-0.046 156.16-156.20 0.026-0.041 156.09-156.12 0.025-0.038

21 160.16-160.24 0.031-0.039 160.17-160.18 0.000-0.043 160.09-160.10 0.025-0.037

22 164.21-164.30 0.024-0.039 164.21-164.24 0.020-0.061 164.15-164.17 0.030-0.041

23 168.34-168.42 0.026-0.039 168.31-168.34 0.030-0.048 168.25-168.28 0.032-0.044

24 172.34-172.42 0.024-0.038 172.30-172.32 0.032-0.055 172.25-172.27 0.025-0.033

25 176.33-176.41 0.024-0.034 176.30-176.33 0.029-0.044 176.24-176.26 0.027-0.037

26 180.35-180.44 0.023-0.036 180.33-180.34 0.032-0.041 180.27-180.29 0.026-0.041

27 184.33-184.42 0.019-0.030 184.32-184.34 0.040-0.052 184.26-184.28 0.031-0.044

28 188.44-188.53 0.026-0.041 188.41-188.43 0.032-0.050 188.36-188.38 0.029-0.043

29 192.49-192.58 0.027-0.042 192.46-192.48 0.022-0.047 192.41-192.44 0.034-0.042

DYS391
5 352.78-352.85 0.024-0.035 3563.42-353.45 0.038-0.057 353.34-353.36 0.034-0.049
6 356.84-356.91 0.032-0.042 357.46-357.51 0.032-0.054 357.39-357.42 0.036-0.051
7 360.69-360.78 0.030-0.036 361.40-361.43 0.026-0.057 361.32-361.35 0.040-0.049
8 364.75-364.85 0.034-0.045 365.47-365.49 0.019-0.035 365.40-365.43 0.033-0.057
9 368.74-368.85 0.023-0.042 369.47-369.50 0.024-0.060 369.39-369.43 0.033-0.046

10 372.75-372.87 0.020-0.040 373.47-373.48 0.036-0.076 373.40-373.44 0.032-0.050

11 376.75-376.87 0.029-0.044 377.47-377.47 0.019-0.047 377.38-377.42 0.037-0.044

12 380.81-380.90 0.031-0.052 381.44-381.48 0.018-0.050 381.36-381.39 0.028-0.049

13 384.93-385.02 0.029-0.045 385.56-385.60 0.020-0.063 385.47-385.50 0.037-0.042

14 388.98-389.07 0.024-0.038 389.60-389.62 0.023-0.050 389.50-389.54 0.028-0.036
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Table of typical precision results

Table 10 Example of precision results of seven injections of a Yfiler Plus Allelic Ladder run on a 3130xI
Genetic Analyzer, 3500 Genetic Analyzer, and 3500xL Genetic Analyzer (continued)

3130x/ 3500 3500xL
Allele
Standard deviation Mean Standard deviation Mean Standard deviation Mean
15 393.02-393.08 | 0.026-0.046 | 393.63-393.67 | 0.024-0.043 | 393.55-393.57 | 0.033-0.045
16 397.05-397.12 0.031-0.042 | 397.66-397.70 | 0.022-0.057 | 397.58-397.61 0.032-0.047
DYS392
4 273.67-273.77 0.028-0.036 274.35-274.38 0.045-0.056 274.25-274.28 0.039-0.047
5 276.63-276.74 0.027-0.044 277.36-277.39 0.048-0.063 277.25-277.28 0.030-0.048
6 279.61-279.73 | 0.021-0.038 | 280.32-280.35 | 0.033-0.051 280.22-280.25 | 0.045-0.054
7 282.64-282.75 0.023-0.032 283.35-283.39 0.042-0.056 283.26-283.29 0.037-0.048
8 285.54-285.66 0.026-0.030 286.23-286.25 0.050-0.065 286.12-286.16 0.032-0.048
9 288.52-288.60 | 0.027-0.036 | 289.12-289.14 | 0.040-0.057 | 289.00-289.04 | 0.034-0.044
10 291.25-291.38 | 0.026-0.040 | 291.97-292.00 | 0.049-0.065| 291.87-291.89 | 0.034-0.052
11 294.30-294.42 0.026-0.039 295.04-295.05 0.051-0.072 294.91-294.94 0.030-0.055
12 297.26-297.38 0.026-0.038 297.96-297.99 0.036-0.058 297.84-297.88 0.035-0.058
13 300.19-300.30 | 0.031-0.045 | 300.89-300.90 | 0.037-0.067 | 300.77-300.80 | 0.038-0.047
14 303.01-303.13 | 0.027-0.036 | 303.73-303.74 | 0.048-0.061 303.59-303.63 | 0.036-0.050
15 306.00-306.12 0.028-0.040 306.70-306.74 0.043-0.070 306.59-306.63 0.033-0.052
16 309.03-309.15 0.026-0.044 309.71-309.73 0.041-0.073 309.58-309.62 0.038-0.053
17 311.93-312.06 0.027-0.044 312.67-312.70 0.027-0.064 312.54-312.58 0.027-0.047
18 314.96-315.09 | 0.029-0.040 | 315.75-315.77 | 0.019-0.060 | 315.61-315.65 | 0.042-0.051
19 318.11-318.23 0.022-0.035 318.88-318.90 0.028-0.056 318.75-318.78 0.035-0.047
20 321.21-321.35 0.022-0.039 321.97-322.00 0.049-0.063 321.84-321.88 0.027-0.058
DYS393

7 90.33-90.36 0.021-0.032 90.35-90.39 0.027-0.037 90.23-90.25 0.029-0.037
8 94.35-94.36 0.024-0.037 94.37-94.42 0.020-0.032 94.27-94.28 0.033-0.041
9 98.51-98.53 0.020-0.030 98.53-98.56 0.028-0.039 98.43-98.44 0.040-0.044
10 102.63-102.64 0.014-0.029 102.67-102.70 0.021-0.052 102.56-102.57 0.033-0.040
11 106.89-106.90 | 0.019-0.027 106.94-106.96 | 0.026-0.037 106.82-106.84 | 0.029-0.037
12 110.79-110.81 0.024-0.030 110.85-110.88 0.039-0.056 110.74-110.76 0.031-0.041
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Table 10 Example of precision results of seven injections of a Yfiler Plus Allelic Ladder run on a 3130xI
Genetic Analyzer, 3500 Genetic Analyzer, and 3500xL Genetic Analyzer (continued)

3130x/ 3500 3500xL
Allele

Standard deviation Mean Standard deviation Mean Standard deviation Mean

13 114.80-114.81 0.017-0.028 114.87-114.91 0.020-0.041 114.76-114.78 0.026-0.035

14 118.72-118.74 0.021-0.029 118.79-118.81 0.033-0.043 118.67-118.69 0.010-0.032

15 122.51-122.53 0.024-0.036 122.61-122.62 0.031-0.044 122.48-122.49 0.030-0.041

16 126.56-126.59 0.017-0.029 126.66-126.68 0.029-0.046 126.54-126.56 0.036-0.041

17 130.54-130.55 0.015-0.033 130.62-130.66 0.023-0.036 130.51-130.53 0.027-0.041

18 134.51-134.54 0.019-0.029 134.61-134.64 0.025-0.038 134.52-134.53 0.030-0.043

DYS437

10 177.93-177.98 0.027-0.035 178.26-178.28 0.031-0.053 178.20-178.22 0.030-0.047

11 181.97-182.01 0.026-0.036 182.29-182.32 0.030-0.045 182.24-182.26 0.040-0.046

12 186.02-186.07 0.021-0.041 186.35-186.38 0.027-0.041 186.31-186.32 0.031-0.046

13 189.98-190.02 0.020-0.039 190.28-190.31 0.020-0.051 190.24-190.26 0.033-0.043

14 194.03-194.07 0.023-0.041 194.34-194.37 0.028-0.049 194.29-194.31 0.041-0.044

15 198.15-198.20 0.025-0.031 198.49-198.51 0.017-0.040 198.46-198.47 0.035-0.046

16 202.13-202.19 0.030-0.037 202.47-202.50 0.026-0.047 202.44-202.45 0.035-0.041

17 206.08-206.12 0.023-0.034 206.42-206.45 0.026-0.056 206.36-206.38 0.033-0.040

18 210.03-210.07 0.022-0.036 210.38-210.41 0.031-0.054 210.33-210.35 0.038-0.045

DYS438
6 207.14-207.22 0.024-0.032 207.69-207.73 0.044-0.059 207.67-207.68 0.033-0.040
7 212.16-212.22 0.025-0.032 212.70-212.71 0.030-0.049 212.66-212.68 0.030-0.054
8 217.23-217.31 0.022-0.038 217.78-217.82 0.029-0.050 217.76-217.77 0.032-0.038
9 222.32-222.41 0.023-0.032 222.87-222.90 0.023-0.064 222.86-222.87 0.030-0.040

10 227.38-227.47 0.027-0.030 227.91-227.94 0.016-0.068 227.90-227.93 0.036-0.054

11 232.43-232.52 0.032-0.037 232.96-232.98 0.031-0.065 232.95-232.98 0.032-0.046

12 237.48-237.58 0.021-0.038 238.03-238.04 0.035-0.047 238.00-238.03 0.032-0.049

13 242.64-242.71 0.024-0.033 243.14-243.17 0.027-0.052 243.14-243.16 0.025-0.037

14 247.82-247.87 0.022-0.031 248.30-248.32 0.040-0.050 248.28-248.31 0.033-0.046

15 252.87-252.90 0.022-0.037 253.31-253.33 0.027-0.056 253.31-253.34 0.024-0.041
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Table 10 Example of precision results of seven injections of a Yfiler Plus Allelic Ladder run on a 3130xI
Genetic Analyzer, 3500 Genetic Analyzer, and 3500xL Genetic Analyzer (continued)

3130x/ 3500 3500xL
Allele
Standard deviation Mean Standard deviation Mean Standard deviation Mean
16 257.80-257.85 0.014-0.029 258.24-258.26 0.021-0.041 258.24-258.27 0.034-0.039
DYS439
6 149.93-150.01 0.016-0.027 150.28-150.31 0.021-0.046 150.23-150.24 0.028-0.039
7 154.05-154.12 0.020-0.036 154.38-154.41 0.033-0.055 154.32-154.34 0.034-0.041
8 158.15-158.23 | 0.031-0.036 158.51-158.52 | 0.031-0.052 158.43-158.46 | 0.025-0.046
9 162.21-162.30 | 0.024-0.034 162.54-162.59 | 0.036-0.046 162.49-162.50 | 0.036-0.043
10 166.33-166.41 0.023-0.029 166.65-166.69 0.033-0.039 166.60-166.62 0.026-0.044
11 170.27-170.36 0.022-0.032 170.60-170.64 0.039-0.054 170.56-170.59 0.027-0.045
12 174.30-174.39 0.020-0.032 174.64-174.67 0.029-0.050 174.58-174.61 0.028-0.045
13 178.38-178.47 0.027-0.047 178.72-178.75 0.032-0.052 178.66-178.70 0.041-0.046
14 182.44-182.52 0.029-0.035 182.78-182.81 0.035-0.051 182.74-182.76 0.025-0.045
15 186.45-186.53 0.024-0.033 186.79-186.82 0.029-0.052 186.76-186.78 0.036-0.044
16 190.51-190.60 | 0.025-0.042 190.86-190.88 | 0.026-0.048 190.83-190.85 | 0.037-0.047
17 194.58-194.66 0.024-0.040 194.93-194.96 0.027-0.054 194.90-194.93 0.034-0.047
DYS448
14 277.79-277.88 0.032-0.045 278.38-278.41 0.033-0.059 278.39-278.41 0.040-0.063
15 283.72-283.80 0.021-0.044 284.33-284.34 0.030-0.065 284.31-284.34 0.034-0.048
16 289.61-289.69 | 0.033-0.043 | 290.22-290.25 | 0.031-0.062 | 290.21-290.24 | 0.031-0.050
17 295.50-295.59 0.031-0.045 296.12-296.14 0.039-0.060 296.11-296.13 0.039-0.059
18 301.34-301.43 0.036-0.043 301.98-302.00 0.040-0.061 301.95-302.00 0.040-0.066
19 307.17-307.28 | 0.035-0.043 | 307.85-307.88 | 0.042-0.061 307.83-307.87 | 0.037-0.050
20 313.18-313.29 | 0.038-0.048 | 313.87-313.91 0.051-0.079 | 313.86-313.90 | 0.040-0.060
21 319.33-319.45 0.036-0.049 320.06-320.09 0.035-0.052 320.06-320.10 0.039-0.066
22 325.50-325.63 0.041-0.053 326.21-326.23 0.038-0.062 326.22-326.26 0.049-0.060
23 331.46-331.61 0.036-0.056 | 332.16-332.19 | 0.039-0.070 | 332.16-332.20 | 0.045-0.066
24 337.39-337.53 | 0.038-0.051 338.10-338.14 | 0.024-0.077 | 338.11-338.15 | 0.040-0.060
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Table 10 Example of precision results of seven injections of a Yfiler Plus Allelic Ladder run on a 3130xI
Genetic Analyzer, 3500 Genetic Analyzer, and 3500xL Genetic Analyzer (continued)

3130x/ 3500 3500xL
Allele
Standard deviation Mean Standard deviation Mean Standard deviation Mean
DYS449
22 325.50-325.57 | 0.027-0.062 | 325.58-325.61 0.037-0.049 | 325.63-325.67 | 0.035-0.049
23 329.59-329.64 0.027-0.064 329.65-329.67 0.028-0.054 329.71-329.73 0.039-0.060
24 333.63-333.66 0.025-0.062 333.66-333.72 0.025-0.041 333.75-333.76 0.032-0.045
25 337.66-337.69 | 0.031-0.058 | 337.68-337.72 |0.033-0.045| 337.76-337.78 | 0.027-0.040
26 341.69-341.75 0.029-0.052 341.72-341.77 0.025-0.042 341.79-341.81 0.039-0.051
27 345.76-345.87 0.029-0.050 345.80-345.84 0.031-0.049 345.87-345.88 0.032-0.043
28 349.82-349.93 0.028-0.061 349.87-349.89 0.018-0.051 349.93-349.94 0.029-0.039
29 353.87-353.98 | 0.025-0.053 | 353.92-353.95 | 0.020-0.060 | 353.98-353.99 | 0.034-0.044
30 357.92-358.03 | 0.028-0.060 | 357.97-358.00 | 0.027-0.042 | 358.03-358.06 | 0.035-0.050
31 361.97-362.04 0.036-0.045 362.01-362.04 0.021-0.040 362.07-362.09 0.032-0.059
32 365.98-366.06 0.034-0.042 366.01-366.04 0.038-0.055 366.08-366.10 0.035-0.041
33 369.99-370.07 | 0.029-0.042 | 370.00-370.04 | 0.038-0.048 | 370.08-370.11 0.030-0.047
34 373.99-374.09 0.025-0.044 374.02-374.04 0.027-0.061 374.09-374.12 0.033-0.053
35 377.99-378.08 0.032-0.047 378.01-378.06 0.040-0.055 378.10-378.11 0.039-0.047
36 382.03-382.12 0.034-0.043 382.03-382.08 0.027-0.053 382.12-382.13 0.031-0.051
37 386.08-386.18 | 0.022-0.043 | 386.09-386.12 | 0.025-0.045 | 386.17-386.19 | 0.034-0.048
38 390.12-390.22 0.020-0.042 | 390.14-390.16 | 0.025-0.044 | 390.21-390.23 | 0.036-0.044
39 394.14-394.28 0.030-0.043 394.18-394.20 0.029-0.049 394.24-394.26 0.037-0.043
40 398.17-398.31 0.029-0.053 398.21-398.25 0.024-0.047 398.27-398.29 0.030-0.038
DYS456
10 76.25-76.30 0.033-0.043 76.25-76.28 0.044-0.050 76.08-76.10 0.031-0.042
11 80.51-80.56 0.016-0.036 80.54-80.56 0.025-0.047 80.40-80.42 0.026-0.037
12 84.72-84.78 0.023-0.035 84.74-84.77 0.009-0.043 84.63-84.64 0.028-0.035
13 88.92-88.97 0.020-0.036 88.95-88.99 0.021-0.035 88.84-88.85 0.024-0.036
14 93.11-93.16 0.022-0.036 93.13-93.17 0.024-0.047 93.03-93.05 0.028-0.039
15 97.28-97.34 0.024-0.037 97.30-97.35 0.027-0.038 97.23-97.24 0.021-0.035
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Table 10 Example of precision results of seven injections of a Yfiler Plus Allelic Ladder run on a 3130xI
Genetic Analyzer, 3500 Genetic Analyzer, and 3500xL Genetic Analyzer (continued)

3130x/ 3500 3500xL
Allele
Standard deviation Mean Standard deviation Mean Standard deviation Mean
16 101.47-101.53 0.022-0.031 101.52-101.55 0.010-0.033 101.42-101.43 0.034-0.040
17 105.65-105.72 0.021-0.030 105.73-105.75 | 0.025-0.038 105.62-105.64 | 0.023-0.035
18 109.81-109.88 0.022-0.037 109.89-109.92 0.023-0.056 109.77-109.80 0.027-0.038
19 113.92-113.98 0.029-0.032 114.01-114.04 0.028-0.060 113.89-113.91 0.032-0.038
20 117.90-117.95 0.022-0.035 118.01-118.02 0.026-0.044 117.88-117.88 0.022-0.029
21 121.86-121.93 0.022-0.036 121.97-122.01 0.040-0.044 121.84-121.86 0.036-0.042
22 125.85-125.93 0.027-0.033 125.98-126.00 0.032-0.048 125.85-125.87 0.032-0.038
23 129.87-129.94 0.029-0.033 130.00-130.04 0.042-0.058 129.88-129.89 0.032-0.040
24 133.89-133.96 | 0.026-0.033 134.04-134.05 | 0.030-0.041 133.92-133.94 | 0.024-0.044
DYS458
11 119.84-119.98 0.027-0.034 120.25-120.28 0.039-0.065 120.11-120.13 0.039-0.041
12 123.66-123.81 0.026-0.038 124.10-124.13 0.042-0.056 123.96-123.98 0.026-0.040
13 127.52-127.66 0.025-0.041 127.97-128.01 0.035-0.053 127.82-127.85 0.027-0.040
14 131.37-131.53 0.033-0.038 131.84-131.90 0.040-0.069 131.70-131.74 0.024-0.041
15 135.26-135.41 0.020-0.043 135.77-135.80 0.035-0.059 135.62-135.65 0.030-0.038
16 139.17-139.32 0.027-0.046 139.68-139.72 0.041-0.051 139.56-139.58 0.028-0.044
17 143.06-143.24 0.030-0.044 143.61-143.64 0.028-0.049 143.47-143.52 0.030-0.040
18 147.14-147.31 0.030-0.045 147.70-147.72 0.033-0.054 147.56-147.59 0.035-0.047
19 151.22-151.39 0.029-0.050 151.77-151.83 0.040-0.060 151.65-151.68 0.034-0.043
20 1565.22-155.39 0.028-0.047 155.79-155.82 0.031-0.062 155.65-155.68 0.029-0.049
21 159.12-159.30 0.028-0.049 159.71-159.73 0.028-0.041 159.57-159.61 0.027-0.042
22 163.07-163.26 | 0.027-0.050 163.65-163.69 | 0.039-0.063 163.52-163.55 | 0.035-0.048
23 166.99-167.18 0.019-0.060 167.58-167.61 0.028-0.059 167.45-167.48 0.030-0.042
24 170.92-171.11 0.028-0.064 171.52-171.54 0.042-0.063 171.38-171.42 0.033-0.044
DYS460
7 79.58-79.61 0.031-0.038 79.58-79.60 0.053-0.060 79.38-79.40 0.023-0.039
8 83.76-83.80 0.021-0.040 83.75-83.78 0.042-0.058 83.58-83.60 0.026-0.037
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Table 10 Example of precision results of seven injections of a Yfiler Plus Allelic Ladder run on a 3130xI
Genetic Analyzer, 3500 Genetic Analyzer, and 3500xL Genetic Analyzer (continued)

3130x/ 3500 3500xL
Allele
Standard deviation Mean Standard deviation Mean Standard deviation Mean
9 87.96-87.98 0.025-0.037 87.92-87.97 0.027-0.035 87.77-87.79 0.029-0.038
10 92.12-92.15 0.024-0.042 92.10-92.13 0.023-0.043 91.95-91.97 0.031-0.044
11 96.29-96.31 0.028-0.041 96.26-96.30 0.030-0.049 96.11-96.13 0.030-0.040

12 100.46-100.48 0.023-0.045 100.44-100.48 0.039-0.048 100.28-100.30 0.034-0.042

13 104.65-104.67 0.028-0.035 104.64-104.67 0.030-0.038 104.48-104.50 0.025-0.039

14 108.80-108.84 0.028-0.039 108.79-108.82 0.025-0.040 108.63-108.66 0.027-0.033

DYS481

17 206.82-206.84 0.018-0.034 206.89-206.93 0.023-0.040 206.96-206.97 0.025-0.038

18 209.80-209.81 0.018-0.032 209.86-209.88 0.027-0.044 209.92-209.93 0.030-0.036

19 212.76-212.78 0.026-0.036 212.86-212.87 0.009-0.050 212.89-212.91 0.037-0.045

20 215.78-215.80 0.021-0.035 215.86-215.88 0.016-0.042 215.91-215.94 0.027-0.042

21 218.85-218.87 0.018-0.033 218.91-218.94 0.010-0.032 218.98-218.99 0.029-0.040

22 221.88-221.90 0.024-0.039 221.93-221.96 0.020-0.042 222.00-222.02 0.038-0.048

23 224.88-224.90 0.023-0.033 224.94-224.97 0.025-0.037 225.02-225.03 0.039-0.049

24 227.88-227.90 0.021-0.032 227.95-227.97 0.037-0.055 228.03-228.04 0.037-0.043

25 230.90-230.92 0.017-0.034 230.96-230.99 0.035-0.054 231.03-231.04 0.030-0.049

26 233.91-233.93 0.022-0.033 233.97-233.98 0.027-0.049 234.04-234.06 0.032-0.042

27 236.91-236.93 0.018-0.034 236.98-237.00 0.023-0.053 237.06-237.07 0.033-0.037

28 239.94-239.95 0.023-0.033 239.99-240.01 0.000-0.048 240.07-240.08 0.026-0.048

29 243.03-243.05 0.023-0.031 243.08-243.10 0.026-0.046 243.15-243.16 0.030-0.034

30 246.11-246.13 0.023-0.031 246.14-246.16 0.025-0.052 246.21-246.23 0.029-0.040

31 249.17-249.21 0.023-0.032 249.18-249.21 0.009-0.038 249.27-249.28 0.030-0.038

32 252.15-252.20 0.025-0.033 252.19-252.20 0.020-0.045 252.27-252.28 0.029-0.039

DYS518

32 332.35-332.38 0.025-0.054 332.32-332.35 0.027-0.045 332.32-332.35 0.038-0.046

33 336.40-336.41 0.029-0.050 336.35—-336.38 0.024-0.045 336.36-336.39 0.030-0.050

34 340.43-340.48 0.026-0.047 340.36-340.40 0.005-0.044 340.39-340.41 0.005-0.041
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Table 10 Example of precision results of seven injections of a Yfiler Plus Allelic Ladder run on a 3130xI
Genetic Analyzer, 3500 Genetic Analyzer, and 3500xL Genetic Analyzer (continued)

3130x/ 3500 3500xL
Allele
Standard deviation Mean Standard deviation Mean Standard deviation Mean
35 344.52-344.59 | 0.025-0.051 344.45-344.49 | 0.032-0.051 344.48-344.50 | 0.035-0.052
36 348.60-348.70 | 0.024-0.047 | 348.54-348.57 | 0.011-0.044 | 348.56-348.59 | 0.027-0.042
37 352.67-352.76 0.025-0.059 352.60-352.64 0.033-0.053 352.63-352.65 0.029-0.042
38 356.74-356.82 0.026-0.054 356.69-356.71 0.038-0.049 356.70-356.73 0.038-0.054
39 360.82-360.88 | 0.025-0.044 | 360.73-360.77 | 0.036-0.049 | 360.77-360.79 | 0.035-0.058
40 364.83-364.91 0.021-0.043 | 364.76-364.78 | 0.026-0.046 | 364.80-364.82 0.030-0.041
41 368.87-368.92 0.021-0.036 368.78-368.80 0.032-0.059 368.82-368.84 0.035-0.046
42 372.87-372.94 0.030-0.038 372.78-372.83 0.033-0.043 372.83-372.85 0.030-0.041
43 376.91-376.98 | 0.026-0.043 | 376.81-376.83 | 0.026-0.057 | 376.84-376.88 | 0.038-0.053
44 380.95-381.01 0.024-0.034 | 380.83-380.86 | 0.041-0.052 | 380.88-380.89 | 0.030-0.049
45 385.00-385.07 0.024-0.038 384.89-384.92 0.019-0.045 384.93-384.95 0.029-0.046
46 389.05-389.14 0.027-0.035 388.96-388.97 0.026-0.054 388.99-389.00 0.038-0.048
47 393.09-393.19 | 0.023-0.043 | 393.00-393.02 | 0.033-0.049 | 393.04-393.06 | 0.025-0.053
48 397.12-397.24 | 0.034-0.047 | 397.04-397.08 | 0.028-0.054 | 397.08-397.12 0.031-0.052
49 401.16-401.26 0.025-0.039 401.08-401.10 0.018-0.041 401.10-401.13 0.031-0.051
DYS533
7 338.37-338.42 0.028-0.035 | 338.61-338.63 | 0.036-0.049 | 338.55-338.56 | 0.020-0.036
8 342.44-342.48 0.024-0.040 342.64-342.69 0.027-0.043 342.61-342.62 0.040-0.046
9 346.54-346.56 0.026-0.038 346.72-346.77 0.028-0.044 346.68-346.70 0.032-0.047
10 350.61-350.63 0.026-0.039 350.82-350.85 0.026-0.053 350.75-350.76 0.033-0.048
11 354.68-354.69 | 0.024-0.035 | 354.87-354.91 0.024-0.037 | 354.81-354.83 | 0.028-0.051
12 358.73-358.77 | 0.026-0.035 | 358.93-358.97 | 0.015-0.059 | 358.88-358.90 | 0.029-0.046
13 362.76-362.78 0.023-0.035 362.96-362.99 0.018-0.043 362.90-362.93 0.028-0.045
14 366.76-366.79 0.021-0.035 366.95-366.99 0.029-0.048 366.92-366.95 0.034-0.043
15 370.78-370.82 0.022-0.029 | 370.99-371.01 0.032-0.064 | 370.94-370.97 | 0.031-0.048
16 374.79-374.82 0.033-0.034 | 374.99-375.02 | 0.030-0.047 | 374.93-374.96 | 0.035-0.047
17 378.80-378.83 0.025-0.039 379.01-379.03 0.010-0.045 378.94-378.97 0.041-0.049
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Table 10 Example of precision results of seven injections of a Yfiler Plus Allelic Ladder run on a 3130xI
Genetic Analyzer, 3500 Genetic Analyzer, and 3500xL Genetic Analyzer (continued)

3130x/ 3500 3500xL
Allele
Standard deviation Mean Standard deviation Mean Standard deviation Mean
DYS570
10 97.99-98.02 0.021-0.034 98.02-98.04 0.026-0.044 97.95-97.96 0.035-0.043
11 102.12-102.15 0.024-0.034 102.13-102.16 0.023-0.041 102.08-102.09 0.028-0.034
12 106.23-106.27 0.021-0.029 106.26-106.29 0.032-0.046 106.20-106.21 0.026-0.036
13 110.33-110.35 0.022-0.033 110.35-110.37 0.032-0.044 110.28-110.30 0.028-0.043
14 114.36-114.38 0.018-0.030 114.40-114.41 0.024-0.038 114.32-114.34 0.017-0.037
15 118.29-118.32 0.021-0.030 118.32-118.34 0.022-0.037 118.23-118.25 0.035-0.038
16 122.21-122.24 0.023-0.041 122.23-122.26 0.032-0.041 122.15-122.17 0.027-0.036
17 126.18-126.21 0.026-0.041 126.21-126.22 0.030-0.042 126.13-126.14 0.027-0.042
18 130.16-130.19 0.021-0.041 130.18-130.20 0.015-0.039 130.11-130.12 0.028-0.034
19 134.15-134.19 0.027-0.038 134.18-134.21 0.025-0.038 134.11-134.13 0.026-0.041
20 138.19-138.23 0.026-0.043 138.20-138.25 0.027-0.046 138.14-138.16 0.027-0.036
21 142.27-142.30 0.024-0.033 142.29-142.31 0.024-0.037 142.23-142.25 0.034-0.040
22 146.38-146.42 0.021-0.028 146.39-146.42 0.020-0.033 146.34-146.35 0.028-0.038
23 150.50-150.55 0.027-0.031 150.49-150.51 0.035-0.046 150.45-150.47 0.025-0.039
24 154.62-154.67 0.023-0.040 154.61-154.64 0.027-0.039 154.57-154.60 0.027-0.036
25 158.75-158.81 0.024-0.038 158.73-158.75 | 0.034-0.038 158.69-158.70 | 0.016-0.029
26 162.84-162.88 0.027-0.042 162.80-162.82 0.019-0.042 162.76-162.79 0.031-0.040
DYS576
10 72.26-72.37 0.028-0.050 72.79-72.82 0.041-0.073 72.45-72.47 0.038-0.045
11 76.42-76.55 0.027-0.043 77.02-77.03 0.059-0.066 76.69-76.71 0.028-0.047
12 80.56-80.68 0.020-0.038 81.18-81.20 0.039-0.064 80.88-80.89 0.036-0.040
13 84.65-84.77 0.021-0.033 85.27-85.30 0.040-0.052 84.98-85.01 0.031-0.037
14 88.71-88.86 0.029-0.041 89.35-89.38 0.040-0.068 89.07-89.10 0.029-0.040
15 92.79-92.93 0.026-0.043 93.42-93.47 0.039-0.057 93.17-93.19 0.024-0.040
16 96.84-96.99 0.029-0.039 97.49-97.54 0.041-0.055 97.24-97.26 0.029-0.040
17 100.90-101.05 0.021-0.045 101.59-101.63 0.027-0.051 101.34-101.35 0.038-0.039
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Table 10 Example of precision results of seven injections of a Yfiler Plus Allelic Ladder run on a 3130xI
Genetic Analyzer, 3500 Genetic Analyzer, and 3500xL Genetic Analyzer (continued)

3130x/ 3500 3500xL
Allele
Standard deviation Mean Standard deviation Mean Standard deviation Mean
18 104.98-105.14 | 0.029-0.040 105.69-105.72 | 0.038-0.069 105.41-105.44 | 0.026-0.037
19 109.02-109.19 | 0.026-0.053 109.73-109.77 | 0.033-0.071 109.47-109.49 | 0.025-0.043
20 113.02-113.20 0.025-0.050 113.76-113.79 0.037-0.080 113.49-113.50 0.034-0.040
21 116.93-117.09 0.029-0.042 117.65-117.67 0.033-0.065 117.38-117.40 0.031-0.040
22 120.77-120.95 0.025-0.042 121.51-121.54 0.042-0.074 121.23-121.27 0.026-0.041
23 124.66-124.83 0.029-0.042 125.43-125.46 0.041-0.081 125.14-125.17 0.030-0.039
24 128.56-128.74 0.030-0.050 129.36-129.38 0.062-0.069 129.07-129.09 0.028-0.040
25 132.47-132.66 0.025-0.042 133.28-133.32 0.035-0.072 132.99-133.04 0.029-0.036
DYS627
11 323.89-324.05 | 0.049-0.059 | 325.01-325.03 | 0.048-0.094 | 324.93-324.98 | 0.052-0.066
12 327.79-327.94 0.043-0.066 328.92-328.97 0.038-0.095 328.84-328.89 0.058-0.074
13 331.66-331.84 0.033-0.053 332.81-332.85 0.053-0.080 332.73-332.77 0.048-0.070
14 335.53-335.71 0.046-0.062 | 336.67-336.72 | 0.045-0.086 | 336.61-336.65 | 0.055-0.063
15 339.38-339.53 | 0.040-0.056 | 340.53-340.57 | 0.054-0.086 | 340.45-340.50 | 0.044-0.070
16 343.29-343.42 0.040-0.055 344.42-344.47 0.025-0.103 344.35-344.42 0.048-0.056
17 347.21-347.32 0.040-0.060 348.36-348.40 0.050-0.101 348.28-348.33 0.047-0.059
18 351.11-351.22 0.037-0.061 352.27-352.31 0.052-0.097 352.19-352.24 0.050-0.071
19 355.07-355.22 0.047-0.062 | 356.26-356.29 | 0.050-0.098 | 356.17-356.23 | 0.046-0.063
20 358.90-359.06 0.047-0.060 360.11-360.17 0.048-0.114 360.02-360.10 0.053-0.072
21 362.69-362.85 0.038-0.064 363.92-363.94 0.059-0.092 363.83-363.90 0.053-0.066
22 366.53-366.69 | 0.049-0.070 | 367.77-367.80 | 0.040-0.095 | 367.69-367.75 | 0.051-0.067
23 370.36-370.53 | 0.045-0.064 | 371.62-371.66 | 0.044-0.075| 371.53-371.61 0.054-0.064
24 374.21-374.37 0.054-0.069 375.47-375.52 0.074-0.077 375.39-375.46 0.062-0.070
25 378.05-378.21 0.059-0.074 379.32-379.36 0.055-0.067 379.23-379.32 0.058-0.067
26 381.90-382.06 | 0.062-0.080 | 383.22-383.27 | 0.059-0.086 | 383.12-383.20 | 0.056-0.074
27 385.79-385.94 | 0.064-0.079 | 387.10-387.14 | 0.069-0.094 | 387.02-387.10 | 0.046-0.073
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Appendix A Table of Precision Results
Table of typical precision results

Table 10 Example of precision results of seven injections of a Yfiler Plus Allelic Ladder run on a 3130xI
Genetic Analyzer, 3500 Genetic Analyzer, and 3500xL Genetic Analyzer (continued)

3130x/ 3500 3500xL
Allele

Standard deviation Mean Standard deviation Mean Standard deviation Mean

DYS635

15 191.34-191.39 0.026-0.034 191.90-191.92 0.036-0.052 191.76-191.77 0.034-0.046

16 195.40-195.44 0.024-0.038 195.95-195.98 0.030-0.049 195.82-195.83 0.033-0.047

17 199.45-199.49 0.025-0.036 200.00-200.01 0.000-0.056 199.87-199.88 0.042-0.046

18 203.42-203.46 0.020-0.036 203.96-203.98 0.021-0.048 203.82-203.83 0.031-0.044

19 207.37-207.41 0.021-0.038 207.92-207.94 0.022-0.040 207.77-207.79 0.030-0.040

20 211.35-211.38 0.027-0.036 211.89-211.91 0.017-0.060 211.75-211.77 0.034-0.041

21 215.41-215.44 0.022-0.034 215.96-215.99 0.016-0.059 215.82-215.83 0.030-0.052

22 219.43-219.48 0.027-0.039 219.99-220.01 0.000-0.048 219.85-219.87 0.045-0.046

23 223.44-223.49 0.023-0.037 224.00-224.02 0.033-0.061 223.86-223.89 0.038-0.053

24 227.31-227.38 0.024-0.036 227.88-227.92 0.034-0.051 227.76-227.77 0.034-0.043

25 231.45-231.52 0.023-0.036 232.03-232.06 0.034-0.064 231.91-231.93 0.037-0.050

26 235.35-235.42 0.021-0.030 235.93-235.95 0.039-0.053 235.81-235.84 0.032-0.042

27 239.49-239.55 0.032-0.036 240.07-240.09 0.000-0.058 239.95-239.97 0.043-0.046

28 243.60-243.65 0.026-0.038 24417-244.19 0.023-0.035 244.05-244.09 0.031-0.048

29 247.70-247.75 0.022-0.032 248.24-248.27 0.017-0.039 248.14-248.17 0.038-0.046

30 251.73-251.77 0.021-0.037 252.25-252.29 0.020-0.052 252.14-252.18 0.032-0.045

YGATAH4
8 235.91-235.96 0.022-0.032 236.18-236.22 0.031-0.055 236.15-236.16 0.030-0.047
9 239.92-239.96 0.023-0.036 240.19-240.22 0.031-0.065 240.16-240.18 0.028-0.055

10 244.04-244.09 0.023-0.030 244.31-244.34 0.033-0.047 244.27-244.28 0.030-0.046

11 248.14-248.15 0.018-0.033 248.39-248.41 0.041-0.052 248.35-248.36 0.032-0.047

12 252.15-252.17 0.020-0.034 252.37-252.39 0.020-0.040 252.35-252.37 0.031-0.040

13 256.07-256.10 0.024-0.039 256.31-256.33 0.029-0.039 256.28-256.30 0.027-0.042

14 259.97-260.00 0.015-0.032 260.24-260.27 0.000-0.049 260.19-260.23 0.032-0.047

15 263.94-263.99 0.019-0.042 264.22-264.25 0.019-0.040 264.20-264.22 0.034-0.045
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Troubleshooting

Observation

Possible cause

Recommended action

Faint or no signal from DNA Control
007 and the test samples at all loci

The incorrect volume of master
mix or primer set was used.

Use the correct volume of master mix or
primer set.

The DNA polymerase was not
activated.

Repeat the amplification with an initial
hold for 1 minute at 95°C.

The master mix was not
vortexed thoroughly before
aliquoting.

Vortex the master mix thoroughly.

The primer set was exposed to
too much light.

Replace the primer set and store it
protected from light.

Evaporation.

Ensure that the plate is properly sealed
with film.

The thermal cycler
malfunctioned.

See the thermal cycler user guide and
check the instrument calibration.

Incorrect thermal cycler
conditions were used.

Use the correct thermal cycler
conditions.

The tubes or plate were not
seated tightly in the thermal
cycler during amplification.

Push the tubes or plate firmly into the
block after the first cycle.

The wrong PCR reaction tubes
or plate were used.

Use MicroAmp™ Reaction Tubes with
Caps or a MicroAmp™ Optical 96-Well
Reaction Plate.

Insufficient PCR product was
electrokinetically injected.

Use the correct settings for the capillary
electrophoresis instrument.

Degraded formamide was
used.

Ensure that the formamide is correctly
stored. Do not thaw and refreeze the
formamide multiple times. Try using
Hi-Di™ Formamide.

Positive signal from DNA Control 007
but partial or no signal from the test

samples

The quantity of test DNA
sample is below the assay
sensitivity.

Quantify DNA and (when possible) add
1.0 ng of DNA. For low concentration
samples, add up to 15 pL of the DNA
sample to the reaction mix, or consider
using the 30-cycle protocol.

The test sample contains a
high concentration of PCR
inhibitor (for example, heme
compounds, certain dyes).

Quantify the DNA, then use the
minimum required volume of test sample
DNA.

Wash the sample in a Centricon™-100
centrifugal filter unit.
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Appendix B Troubleshooting
Table of typical precision results

Observation

Possible cause

Recommended action

Positive signal from DNA Control 007
but partial or no signal from the test
samples

(continued)

The test sample DNA is
severely degraded.

Use the Quantifiler™ HP DNA
Quantification Kit or the Quantifiler™

Trio DNA Quantification Kit to evaluate

sample quality during the quantification
step. If DNA is degraded, re-amplify
with an increased amount of DNA or
use the AmpFE{STR™ MiniFiler™ PCR

Amplification Kit.

The test sample was diluted in
the wrong buffer (for example,
a TE buffer with an incorrect
EDTA concentration).

Redilute DNA using low-TE buffer (with
0.1 mM EDTA).

More than two alleles present at a
locus

112

Secondary gene duplication
at DYS385 a/b and/or
DYF387S1 a/b.

Some samples may exhibit uneven peak
height ratios at these markers due to
the stochastic effects of the PCR or

a secondary duplication event in one

of the alleles. We recommend that

allele calls be made based on peaks
that are present (conservative approach)
unless additional evidence is gathered
to conclusively show that a secondary
duplication event has taken place.

Exogenous DNA is present in
the sample.

Use appropriate techniques to avoid
introducing foreign DNA during
laboratory handling.

Stutter product (-1 repeat unit
position) was amplified.

Interpret the results according to your
laboratory procedure. See “Extra peaks:
Stutter” on page 66.

The test sample contained
mixed DNA.

Interpret the results according to your
laboratory procedure. See Chapter 6,
“Experiments and results”.

Incomplete 3’ A base addition
(n—1 bp position) occurred.

In the PCR, include the final extension
step: 22 minutes at 60°C.

The signal exceeds the
dynamic range of the
instrument and is causing
signal "pull-up" into adjacent
channels.

Ensure that the cycle number is
optimized. Use fewer PCR cycles or
interpret the off-scale data according to
your laboratory procedure.

Ensure that you are using the
recommended number of PCR cycles.
Decrease the input DNA amount

and repeat the PCR amplification, or
interpret the off-scale data according to
your laboratory procedure.

Poor spectral separation
occurred.

Perform a spectral calibration.

Confirm that Filter Set J6 modules are
installed and used for analysis.
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Appendix B Troubleshooting
Table of typical precision results

Observation

Possible cause

Recommended action

More than two alleles present at a
locus

(continued)

Too much DNA was present in
the reaction.

Use the recommended amount of
template DNA: 1.0 ng.

The double-stranded DNA was
not completely denatured.

Use the recommended amount of Hi-Di™
Formamide and heat the sample plate
for 3 minutes at 95°C.

Some, but not all, loci are visible on
test sample electropherograms

The punched disc that you
used was too large.

Use a 1.2-mm disc.

Insufficient lysis of the swab
head occurred.

Ensure that the swab heads are
incubated in 400 pL of Prep-n-Go™
Buffer for 20 minutes.

The PCR reaction volume
that you used is less than
the volume required for the
amplification.

Use the correct PCR reaction volume:
15 pL.

STR profiles contain many off-scale
alleles

The PCR cycle number used
was too high.

Perform a sensitivity experiment to
determine the optimal PCR cycle
number based on the sample type.

Blood samples: Too much
liquid blood was spotted onto
the paper substrate.

Spot <100 pL of liquid blood per sample
area.

Poor peak height balance

Incorrect thermal cycler
conditions were used.

Use the correct thermal cycler
conditions.
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Materials required but not supplied

Sample preparation required materials . ....... ... .. 114
Thermal cycler required materials . ... ... e 116
Capillary electrophoresis instrument required materials ......... ... .. ... ... ... . L. 116
Analysis software required materials . .. ... e 118
Miscellaneous required materials .. ......... .. i i e 119

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

Catalog numbers that appear as links open the web pages for those products.

Sample preparation required materials

Extracted DNA

Item Amount Cat. No.

GeneScan™ 600 LIZ™ Size Standard v2.0 2 x 200 pL 4408399

IMPORTANT! Do not use GeneScan™ 350 ROX™, GeneScan™ 500
ROX™, or GeneScan™ 500 LIZ™ Size Standards with this kit.

TE Buffer [low-TE buffer; 10 mM Tris-HCI (pH 8.0) and 0.1 mM EDTA] 100 mL 12090015

or see “(Optional) Prepare low-
TE buffer” on page 21

Hi-Di™ Formamide 25-mL 4311320

Treated paper substrate

Item Source
Collection system
Whatman™ FTA™ Classic Cards MLS
Whatman™ EasiCollect™ system MLS
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Appendix C Materials required but not supplied
Sample preparation required materials

(continued)
Item Source
Sample preparation
Prep-n-Go™ Buffer (for use with untreated paper substrates) 4467079
TE Buffer [low-TE buffer; 10 mM Tris-HCI (pH 8.0) and 0.1 mM EDTA] 12090015
Punch tool
Harris Micro-Punch™ tool, 1.2-mm MLS

BSD600-Duet Semi-Automated Dried Sample Punch Instrument with a 1.2-mm
punch head

Contact your local sales office.
BSD1000-GenePunch Automated Dried Sample Punch Instrument with a 1.2-mm

punch head

Untreated paper substrate

Iltem Source
Collection system
903 paper MLS
Punch tool
Harris Micro-Punch™ tool, 1.2-mm MLS

BSD600-Duet Semi-Automated Dried Sample Punch Instrument with a 1.2-mm
punch head

Contact your local sales office.
BSD1000-GenePunch Automated Dried Sample Punch Instrument with a 1.2-mm

punch head

Swab substrate

ltem Source
Collection system
4N6FLOQSwabs™, regular tip 4473979
Sample preparation
Prep-n-Go™ Buffer (for use with buccal swab substrates) 4471406

Heated lysis protocol only: 1.5 mL tube format or 96-well deep-well plate format

1.5 mL tube format

1.5 mL tubes MLS
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Appendix C Materials required but not supplied
Thermal cycler required materials

(continued)
ltem Source
Oven: VWR™ Scientific dry heat block or equivalent VWR™ Scientific
96-well deep-well plate format
PrepFiler™ 96-Well Processing Plates A47010
Robbins Scientific™ Model 400 Hybridization Incubator or equivalent MLS
Agilent™ Benchtop Rack for 200 pL Tubes/V Bottom Plates (metal) or equivalent
IMPORTANT! Do not use a plastic plate adaptor. Agilent™ Technologies 410094

Thermal cycler required materials

ProFlex™ PCR System

Item Source
ProFlex™ 96-well PCR System 4484075
ProFlex™ 2 x 96-well PCR System 4484076
ProFlex™ 3 x 32-Well PCR System 4484073
VeritiPro™ Thermal Cycler
Item Source
HID VeritiPro™ Thermal Cycler, 96-well A52127

Capillary electrophoresis instrument required materials

SeqStudio™ Flex Series Genetic Analyzer for Human ldentification

Item Source

SeqStudio™ 8 Flex Genetic Analyzer for Human Identification with SeqStudio™ Flex Series Instrument

A56532
Software v1.1.1
SegStudio™ 24 Flex Genetic Analyzer for Human Identification with SeqStudio™ Flex Series Instrument

A56534
Software v1.1.1
Anode Buffer Container 3500/Flex Series 4393927
Cathode Buffer Container 3500/Flex Series 4408256
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Appendix C Materials required but not supplied
Capillary electrophoresis instrument required materials

(continued)

Iltem Source
Septa Cathode Buffer Container 3500/Flex Series 4410715
Capillary array 36-cm SeqStudio™ 8 Flex A49104
Capillary array 36-cm SeqStudio™ 24 Flex A49105
96-Well Standard Retainer & Base Set SeqStudio™ Flex Series A49316
8-Tube Standard Retainer & Base Set SeqStudio™ Flex Series A49296
8-Strip Septa 3500/Flex Series 4410701
Septa for 96-Well Plates, for 3500/SeqStudio™ Flex 4412614
DS-36 Matrix Standard Kit (Dye Set J6) 4425042
POP-4™ (960) Performance Optimized Polymer 4393710
POP-4™ (384) Performance Optimized Polymer 4393715
Conditioning Reagent Kit 3500/Flex Series 4393718

SeqStudio™ Genetic Analyzer for HID

Item

Source

SeqStudio™ Genetic Analyzer for HID with SeqStudio™ Data Collection Software v1.2.1,
v1.2.4,orvl.2.5

A46227

(Optional) SAE Administrator Console v2.0 or v2.1

A46170 or A53717

(Optional) SeqStudio™ Plate Manager v1.2 or v1.3

Thermo Fisher Scientificl'l

SegStudio™ Genetic Analyzer Cartridge v2 A41331
SeqStudio™ Genetic Analyzer Cathode Buffer Container A33401
Reservoir Septa (for Cathode Buffer Container) A35640
SeqStudio™ Integrated Capillary Protector A31923
Septa for SeqStudio™ Genetic Analyzer, 96 well A35641
Septa for SeqStudio™ Genetic Analyzer, 8 strip A35643
DS-36 Matrix Standard Kit (Dye Set J6) 4425042

M Available on apps.thermofisher.com or for download at thermofisher.com.
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Appendix C Materials required but not supplied
Analysis software required materials

3500 Series Genetic Analyzer for Human Identification

ltem Source
3500 Genetic Analyzer for Human Identification with 3500 Series Data Collection Software 4 4406017
3500xL Genetic Analyzer for Human Identification with 3500 Series Data Collection Software 4 4406016
(Software upgrade package) 3500 Series HID Data Collection Software v4.0.1 A46085
Anode Buffer Container 3500/Flex Series 4393927
Cathode Buffer Container 3500/Flex Series 4408256
Septa Cathode Buffer Container 3500/Flex Series 4410715
3500 Genetic Analyzer 8-Capillary Array, 36 cm 4404683
3500xL Genetic Analyzer 24-Capillary Array, 36 cm 4404687
Retainer & Base Set (Standard) for3500/3500xL Genetic Analyzer, 96 well 4410228
Retainer & Base Set (Standard) for3500/3500xL Genetic Analyzer, 8 tube 4410231
8-Strip Septa 3500/Flex Series 4410701
Septa for 96-Well Plates, for 3500/SeqStudio™ Flex 4412614
DS-36 Matrix Standard Kit (Dye Set J6) 4425042
POP-4™ (960) Performance Optimized Polymer 4393710
POP-4™ (384) Performance Optimized Polymer 4393715
Conditioning Reagent Kit 3500/Flex Series 4393718

Analysis software required materials

GeneMapper™ ID-X Software

Item Source
GeneMapper™ ID-X Software v1.7.2 patchl] Thermo Fisher Scientificl?!
GeneMapper™ ID-X Software v1.7 Full Installation A71700
GeneMapper™ ID-X Software v1.7 Client Installation A71701
GeneMapper™ ID-X Software v1.6 Full Installation A39975
GeneMapper™ ID-X Software v1.6 Client Installation A39976
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Appendix C Materials required but not supplied
Miscellaneous required materials

(continued)

Item Source
GeneMapper™ ID-X Software v1.5 Full Installation A27884
GeneMapper™ ID-X Software v1.5 Client Installation A27886

' The patch addresses known issues and provides new user functionality since the v1.7 release.

@ Available for free download at www.thermofisher.com/GMIDXsoftware.

Note: For a list of GeneMapper™ ID-X Software versions that are compatible with your kit and capillary
electrophoresis instrument, see “Instruments and software compatibility” on page 16 .

Miscellaneous required materials

Plates and tubes

Item Source
MicroAmp™ 96-Well Tray N8010541
MicroAmp™ Reaction Tube with Cap, 0.2 mL N8010540
MicroAmp™ 8-Tube Strip, 0.2 mL N8010580
MicroAmp™ Optical 8-Tube Strip, 0.2 mL 4316567
MicroAmp™ Optical 8-Cap Strips 4323032
MicroAmp™ 96-Well Tray/Retainer Set

403081

(Adapter for 8-Tube Strip)
MicroAmp™ 96-Well Base N8010531
MicroAmp™ Clear Adhesive Film 4306311
MicroAmp™ Optical Adhesive Film 4311971
MicroAmp™ Optical 96-Well Reaction Plate N8010560
MicroAmp™ Optical 96-Well Reaction Plate with Barcode 4326659
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Appendix C Materials required but not supplied
Miscellaneous required materials

Laboratory supplies

Item Source
Various procedures
Aerosol resistant pipette tips MLS!]
Microcentrifuge tubes MLS
Pipettors MLS
Tape, labeling MLS
Tube, 50-mL Falcon™ MLS
Tube decapper, autoclavable MLS
Deionized water, PCR grade MLS
Vortex MLS
(Optional) Tabletop centrifuge with 96-Well Plate Adapters MLS
(Optional) Handheld Barcode Scanner 4488442

[ Major laboratory supplier
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Example PCR plate layout

The following layout is recommended for use with the sensitivity experiment in the Perform PCR

Plate layouts

chapter. Create 3 identical plates for amplification at 3 different cycle numbers.

1 2 3 4 5 G 7 g
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Example electrophoresis plate layout

The following layout is recommended for use with the sensitivity experiment in the Perform PCR

chapter.
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Work area setup and lab design

Many resources are available for the appropriate design of a PCR laboratory. If you are using this kit for:

* Forensic DNA testing, see "Forensic Laboratories: Handbook for Facility Planning, Design,
Construction, and Moving", National Institute of Justice, 1998

* Parentage DNA testing, see the "Guidance for Standards for Parentage Relationship Testing
Laboratories", American Association of Blood Banks, 7th edition, 2004

The sensitivity of this kit (and other PCR-based tests) enables amplification of minute quantities of DNA,
necessitating precautions to avoid contamination of samples yet to be amplified (Kwok and Higuchi,
1989).

Process samples carefully to prevent contamination by human DNA. Wear gloves at all times and
change them frequently. Close sample tubes when not in use. Limit aerosol dispersal by handling
sample tubes and reagents carefully.

Note: We do not intend these references for laboratory design to constitute all precautions and care
necessary for using PCR technology.

PCR setup work area materials

122

IMPORTANT! Do not remove these items from the PCR Setup Work Area.

¢ Calculator

* Gloves, disposable

* Marker pen, permanent
* Microcentrifuge

* Microcentrifuge tubes, 1.5-mL, or 2.0-mL, or other appropriate nuclease-free tube (for master mix
preparation)

* Microcentrifuge tube rack
* Pipette tips, sterile, disposable hydrophobic filter-plugged
* Pipettes
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Appendix E PCR work areas
Amplified DNA work area

* Tube decapper that can be autoclaved
* \ortex

Amplified DNA work area

IMPORTANT! Place the thermal cyclers in the Amplified DNA Work Area.

Use only the validated thermal cyclers listed in “Instruments and software compatibility” on page 16 .
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified in the user
documentation may result in personal injury or damage to the instrument or device. Ensure that
anyone using this product has received instructions in general safety practices for laboratories and
the safety information provided in this document.

. Before using an instrument or device, read and understand the safety information provided in the
user documentation provided by the manufacturer of the instrument or device.

. Before handling chemicals, read and understand all applicable Safety Data Sheets (SDSs) and use
appropriate personal protective equipment (gloves, gowns, eye protection, and so on). To obtain
SDSs, visit thermofisher.com/support.
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Appendix F Safety
Chemical safety

Chemical safety

/W\. WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards, ensure laboratory personnel
&~ read and practice the general safety guidelines for chemical usage, storage, and waste provided
below. Consult the relevant SDS for specific precautions and instructions:

. Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer
before you store, handle, or work with any chemicals or hazardous materials. To obtain SDSs, see
the "Documentation and Support" section in this document.

. Minimize contact with chemicals. Wear appropriate personal protective equipment when handling
chemicals (for example, safety glasses, gloves, or protective clothing).

. Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with

sufficient ventilation (for example, fume hood).

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer

cleanup procedures as recommended in the SDS.

. Handle chemical wastes in a fume hood.

. Ensure use of primary and secondary waste containers. (A primary waste container holds the
immediate waste. A secondary container contains spills or leaks from the primary container.
Both containers must be compatible with the waste material and meet federal, state, and local
requirements for container storage.)

. After emptying a waste container, seal it with the cap provided.

. Characterize (by analysis if needed) the waste generated by the particular applications, reagents,
and substrates used in your laboratory.

. Ensure that the waste is stored, transferred, transported, and disposed of according to all local,
state/provincial, and/or national regulations.

. IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal
limitations may apply.

AVERTISSEMENT ! PRECAUTIONS GENERALES EN CAS DE MANIPULATION DE PRODUITS
CHIMIQUES. Pour minimiser les risques, veiller a ce que le personnel du laboratoire lise attentive-
ment et mette en ceuvre les consignes de sécurité générales relatives a I'utilisation et au stockage
des produits chimiques et a la gestion des déchets qui en découlent, décrites ci-dessous. Consulter
également la FDS appropriée pour connaitre les précautions et instructions particulieres a respecter :

. Lire et comprendre les fiches de données de sécurité (FDS) fournies par le fabricant avant de
stocker, de manipuler ou d’utiliser les matériaux dangereux ou les produits chimiques. Pour obtenir
les FDS, se reporter a la section « Documentation et support » du présent document.

. Limiter les contacts avec les produits chimiques. Porter des équipements de protection appropriés
lors de la manipulation des produits chimiques (par exemple : lunettes de slreté, gants ou véte-
ments de protection).

. Limiter I'inhalation des produits chimiques. Ne pas laisser les récipients de produits chimiques
ouverts. lls ne doivent étre utilisés qu’avec une ventilation adéquate (par exemple, sorbonne).

. Vérifier régulierement I’absence de fuite ou d’écoulement des produits chimiques. En cas de fuite
ou d’écoulement d’un produit, respecter les directives de nettoyage du fabricant recommandées
dans la FDS.

. Manipuler les déchets chimiques dans une sorbonne.
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Appendix F Safety
Biological hazard safety

. Veiller a utiliser des récipients a déchets primaire et secondaire. (Le récipient primaire contient les
déchets immédiats, le récipient secondaire contient les fuites et les écoulements du récipient pri-
maire. Les deux récipients doivent étre compatibles avec les matériaux mis au rebut et conformes
aux exigences locales, nationales et communautaires en matiére de confinement des récipients.)

. Une fois le récipient a déchets vidé, il doit étre refermé hermétiquement avec le couvercle fourni.

. Caractériser (par une analyse si nécessaire) les déchets générés par les applications, les réactifs et
les substrats particuliers utilisés dans le laboratoire.

. Vérifier que les déchets sont convenablement stockés, transférés, transportés et éliminés en res-
pectant toutes les réglementations locales, nationales et/ou communautaires en vigueur.

. IMPORTANT ! Les matériaux représentant un danger biologique ou radioactif exigent parfois une
manipulation spéciale, et des limitations peuvent s’appliquer a leur élimination.

Biological hazard safety

WARNING! Potential Biohazard. Depending on the samples used on this instrument, the surface
may be considered a biohazard. Use appropriate decontamination methods when working with
biohazards.

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids, infectious agents,

and blood of humans and other animals have the potential to transmit infectious diseases.

Conduct all work in properly equipped facilities with the appropriate safety equipment (for example,
physical containment devices). Safety equipment can also include items for personal protection,

such as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety glasses, or
goggles. Individuals should be trained according to applicable regulatory and company/ institution
requirements before working with potentially biohazardous materials. Follow all applicable local,
state/provincial, and/or national regulations. The following references provide general guidelines when
handling biological samples in laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological and Biomedical
Laboratories (BMBL), 6th Edition, HHS Publication No. (CDC) 300859, Revised June 2020
cdc.gov/labs/bmbl

. Laboratory biosafety manual, fourth edition. Geneva: World Health Organization; 2020 (Laboratory
biosafety manual, fourth edition and associated monographs)
who.int/publications/i/item/9789240011311
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Documentation and support

Related documentation

Table 11 STR and quantification kits

Reference

Document title Pub. No.
STR kits
Yfiler™ Plus PCR Amplification Kit— PCR Setup: Treated and MAN1001550
Untreated Paper Substrates Quick Reference
Yfiler™ Plus PCR Amplification Kit— PCR Setup: Extracted DNA MAN1001548
Quick Reference
Yfiler™ Plus PCR Ampilification Kit—PCR Setup: Swab Substrate MAN1001549
Quick Reference
Yfiler™ Plus PCR Amplification Kit— PCR Ampilification and CE Quick MAN1001551

Yfiler™ Plus PCR Amplification Kit

Technical Note: Artifacts Identified Post-Developmental Validation:

Technical Note: Handling STR Kits and Ladder Decontamination

Go to thermofisher.com, then search for the
technical note by title, or contact your local
Human Identification representative.

Quantification kits

Quantifiler™ HP and Quantifiler™ Trio DNA Quantification Kits User
Guide

4485354

Table 12 Thermal cyclers

Document title Pub. No.
ProFlex™ PCR System
ProFlex™ PCR System User Guide MANOO007697
ProFlex™ PCR System Kit Validation User Bulletin 100031595!]
VeritiPro™ Thermal Cycler
VeritiPro™ Thermal Cycler User Guide MANO0019157
HID VeritiPro™ Thermal Cycler, 96-well, User Bulletin— Applied Biosystems™ PCR Amplification Kit MANO0025561
Validation

[ Archived document. To access, go to https://assets.thermofisher.com/TFS-Assets/LSG/manuals/

100031595_ProFlexKit_Validation_UB.pdf

Yfiler™ Plus PCR Amplification Kit User Guide

127


https://www.thermofisher.com/search/results?query=MAN1001550
https://www.thermofisher.com/search/results?query=MAN1001548
https://www.thermofisher.com/search/results?query=MAN1001549
https://www.thermofisher.com/search/results?query=MAN1001551
http://www.thermofisher.com
https://www.thermofisher.com/search/results?query=4485354
https://www.thermofisher.com/search/results?query=MAN0007697
https://www.thermofisher.com/search/results?query=MAN0019157
https://www.thermofisher.com/search/results?query=MAN0025561
https://assets.thermofisher.com/TFS-Assets/LSG/manuals/100031595_ProFlexKit_Validation_UB.pdf
https://assets.thermofisher.com/TFS-Assets/LSG/manuals/100031595_ProFlexKit_Validation_UB.pdf

Appendix G Documentation and support
Related documentation

Table 13 Capillary electrophoresis instruments

Document title Pub. No.
SegStudio™ Flex Series Genetic Analyzer for Human Identification
SeqStudio™ Flex Series Genetic Analyzer with Instrument Software v1.1.1 User Guide 100104689
SeqStudio™ Flex Series Genetic Analyzer for HID Validation User Bulletin MANO0028463
SeqStudio™ Flex Series Instrument Software v1.1.1 User Bulletin MANO0029757
SegStudio™ Genetic Analyzer for HID
SeqStudio™ Genetic Analyzer Instrument and Software User Guide (v1.2 and later) MANO0018646
SeqStudio™ Genetic Analyzer for HID User Bulletin—New Software Features and MAN1001221
Verification/Validation Studies (v1.2 and later)
3500 Series Genetic Analyzer for Human Identification
3500 Series Data Collection Software 4 User Bulletin: New Features and Developmental Validation 100075298
3500/3500xL Genetic Analyzer with 3500 Series Data Collection Software v3.3 User Guide 100079380

Table 14 Analysis software

Document title Pub. No.
GeneMapper™ ID-X Software all versions
GeneMapper™ ID-X Software Bin Overlap User Bulletin 100029546

Technical Note: Compendium of GeneMapper™ ID-X Software version changes from
version 1.0.1 through version 1.7.2

Thermo Fisher Scientific!l]

GeneMapper™ ID-X Software v1.7

GeneMapper™ ID-X Software v1.7 Administration Guide MANO0029245
GeneMapper™ ID-X Software v1.7 Installation Guide MAN0029246
GeneMapper™ ID-X Software v1.7 New Features and Software Verification and MAN0029209
Validation User Bulletin

GeneMapper™ ID-X Software v1.6

GeneMapper™ ID-X Software v1.6 New Features and Software Verification User Bulletin 100073905
GeneMapper™ ID-X Software v1.5

GeneMapper™ ID-X Software v1.5 New Features and Verification User Bulletin 100031708
GeneMapper™ ID-X Software v1.5 Getting Started Guide— Basic Features 100031701
GeneMapper™ ID-X Software v1.5 Quick Reference— Basic Features 100031702
GeneMapper™ ID-X Software v1.5 Getting Started Guide— Mixture Analysis Tool 100031704
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Appendix G Documentation and support
Customer and technical support

Table 14 Analysis software (continued)

Document title Pub. No.
GeneMapper™ ID-X Software v1.5 Quick Reference— Mixture Analysis Tool 100031705
GeneMapper™ ID-X Software v1.5 Installation Guide 100031706
GeneMapper™ ID-X Software v1.5 Administrator Guide 100031703
GeneMapper™ ID-X Software v1.5 Reference Guide 100031707

1 Go to thermofisher.com, then search for the technical note by title, or contact your local Human Identification representative.

Customer and technical support

For support, use one of the contact methods listed below, depending on your location.

Location Contact method

In North America Send an email to:

HIDTechSupport@thermofisher.com

Call 888-821-4443; select option 2, say "Application Support", then say "HID" or
"Human Identification".

Outside North America | Contact your local support office.

For the latest services and support information for all locations, go to thermofisher.com/support to
obtain the following information.

* Worldwide contact telephone numbers

* Product support

® Order and web support

e Safety Data Sheets (SDSs; also known as MSDSs)

Additional product documentation, including user guides and Certificates of Analysis, are available by
contacting Customer Support.

Limited product warranty

Life Technologies Corporation and its affiliates warrant their products as set forth in the

Life Technologies' General Terms and Conditions of Sale at www.thermofisher.com/us/en/
home/global/terms-and-conditions.html. If you have questions, contact Life Technologies at
www.thermofisher.com/support.
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